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C H A P T E R 8

Create Circuits and VT Tunnels

This chapter explains how to create Cisco ONS 15454 electrical circuits, tunnels, OC-N circuits, 
Ethernet circuits, dense wavelength division multiplexing (DWDM) optical channel network 
connections, and virtual concatenated (VCAT) circuits. For additional information about ONS 15454 
circuits, refer to the “Circuits and Tunnels” chapter in the Cisco ONS 15454 Reference Manual.

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A127 Verify Network Turn Up, page 8-4—Complete this procedure before you create any 
circuits.

2. NTP-A181 Create an Automatically Routed DS-1 Circuit, page 8-6—Complete as needed.

3. NTP-A182 Create a Manually Routed DS-1 Circuit, page 8-13—Complete as needed.

4. NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 8-18—Complete as 
needed.

5. NTP-A184 Create an Automatically Routed DS-3 Circuit, page 8-22—Complete as needed.

6. NTP-A185 Create a Manually Routed DS-3 Circuit, page 8-27—Complete as needed.

7. NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 8-29—Complete as 
needed.

8. NTP-A133 Create an Automatically Routed VT Tunnel, page 8-33—Complete as needed.

9. NTP-A134 Create a Manually Routed VT Tunnel, page 8-35—Complete as needed.

10. NTP-A187 Create a VT Aggregation Point, page 8-37—Complete as needed.

11. NTP-A135 Test Electrical Circuits, page 8-40—Complete this procedure after you create an 
electrical circuit.
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12. NTP-A188 Create an Automatically Routed OC-N Circuit, page 8-42—Complete as needed.

13. NTP-A189 Create a Manually Routed OC-N Circuit, page 8-47—Complete as needed.

14. NTP-A190 Create a Unidirectional OC-N Circuit with Multiple Drops, page 8-51—Complete as 
needed.

15. NTP-A62 Test OC-N Circuits, page 8-54—Complete this procedure after you create an optical 
(OC-N) circuit.

16. NTP-A139 Create a Half Circuit on a BLSR or 1+1 Node, page 8-56—Complete this procedure as 
needed to create a half circuit using an OC-N as a destination in a bidirectional line switched ring 
(BLSR) or 1+1 topology.

17. NTP-A140 Create a Half Circuit on a Path Protection Node, page 8-58—Complete as needed to 
create a half circuit using an OC-N as a destination in a path protection.

18. NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card Mode), page 
8-61—Complete as needed.

19. NTP-A192 Create a Circuit for an E-Series Card in Port-Mapped Mode, page 8-68—Complete as 
needed.

20. NTP-A142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 8-70—Complete as 
needed.

21. NTP-A143 Create an E-Series Hub-and-Spoke Ethernet Configuration, page 8-73—Complete as 
needed.

22. NTP-A144 Create an E-Series Single-Card EtherSwitch Manual Cross-Connect, page 
8-75—Complete as needed.

23. NTP-A145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect, page 
8-77—Complete as needed.

24. NTP-A146 Test E-Series Circuits, page 8-81—Complete this procedure after creating E-Series 
SONET circuits.

25. NTP-A147 Create a G-Series STS Circuit, page 8-82—Complete as needed.

26. NTP-A148 Create a Manual Cross-Connect for a G-Series or E-Series Card in Port-Mapped Mode, 
page 8-84—Complete as needed.

27. NTP-A241 Provision G-Series Ports for Transponder Mode, page 8-88—Complete as needed.

28. NTP-A149 Test G-Series Circuits, page 8-91—Complete this procedure after creating G-Series 
SONET circuits.

29. NTP-A194 Create Overhead Circuits, page 8-93—Complete as needed to create data 
communications channel (DCC) tunnels or IP-encapsulated tunnels, provision orderwire, or create 
user data channel circuits.

30. NTP-A227 Provision a DWDM Optical Channel Network Connection, page 8-98—Complete as 
needed.

31. NTP-A264 Create an Automatically Routed VCAT Circuit, page 8-99—Complete as needed.

32. NTP-A265 Create a Manually Routed VCAT Circuit, page 8-103—Complete as needed.

Table 8-1 defines ONS 15454 circuit creation terms and options.
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ONS 15454 circuits are either VT or STS circuits. Table 8-2 shows the circuit source and destination 
options for VT circuits. 

Table 8-1 ONS 15454 Circuit Options

Circuit Option Description

Source The circuit source is where the circuit enters the ONS 15454 network.

Destination The circuit destination is where the circuit exits an ONS 15454 network.

Automatic 
circuit routing

Cisco Transport Controller (CTC) routes the circuit automatically on the shortest 
available path based on routing parameters and bandwidth availability.

Manual circuit 
routing

Manual routing allows you to choose a specific path, not just the shortest path chosen 
by automatic routing. You can choose a specific synchronous transport signal (STS) 
or virtual tributary (VT) for each circuit segment and create circuits from work orders 
prepared by an operations support system (OSS) like the Telcordia Trunk Information 
Record Keeping System (TIRKS).

VT tunnel VT tunnels allow VT1.5 circuits to pass through an ONS 15454 without utilizing 
cross-connect card (XC, XCVT, XC10G) resources. VT circuits using VT tunnels use 
cross-connect capacity only at the source and destination nodes. One VT tunnel can 
carry 28 VT1.5 circuits.

VT aggregation 
point

VT aggregation points (VAPs) allow VT circuits to be aggregated into an STS for 
handoff to non-ONS 15454 networks or equipment, such as interoffice facilities 
(IOFs), switches, or digital access cross-connect systems. VAPs reduce VT matrix 
resource utilization at the node where the VT1.5s are aggregated onto the STS. This 
node is called the STS grooming end. The STS grooming end requires an OC-N, 
EC-1, or DS3XM-6 card. VT aggregation points can be created on BLSR, 1+1, or 
unprotected nodes, but cannot be created on path protection nodes.

Table 8-2 CTC Circuit Source and Destination Options for VT Circuits

Card Ports STSs VTs DS1s

DS1-14, DS1N-14 — — — 14 

DS3XM-6 6 — — 28 per port

EC1-12 12 — 28 per port —

OC3 IR 4/STM1 SH 1310 4 3 per port 28 per STS —

OC3 IR/STM1 SH 1310-8 8 3 per port 28 per STS —

OC12 IR/STM4 SH 1310
OC12 LR/STM4 LH 1310
OC12 LR/STM4 LH 1550

— 12 28 per STS —

OC12 IR/STM4 SH 1310-4 4 12 per port 28 per STS —

All OC-48 cards (does not include 
the ML-Series card)

— 48 28 per STS —

All OC-192 cards — 192 28 per STS —

FC_MC-41

1. For contiguous concatenated (CCAT) circuits, the FC_MC-4 card maps STS-24c or STS-48c to a port. For VCAT, 
the FC_MC-4 card maps STS3c-8v to a port. 

4 — — —
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Table 8-3 shows the shows the circuit source and destination options for STS circuits.

NTP-A127 Verify Network Turn Up

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24. If you are already logged in, continue with 
Step 2.

Step 2 From the View menu, choose Go to Network View. Wait for all the nodes that are part of the network 
to appear on the network map. (Large networks might take several minutes to display all the nodes.) 

Note If this is the first time your computer has connected to this ONS 15454 network, the node icons 
are stacked on the left side of the graphic area, possibly out of view. Use the scroll bar under the 
network map to display the icons. To separate the icons press Ctrl and drag and drop the icon to 
the new location. Repeat until all the nodes are visible on the graphic area.

Table 8-3 CTC Circuit Source and Destination Options for STS Circuits 

Card Ports STSs

DS1-14, DS1N-141

1. You can route one STS circuit on a DS-1 card to carry all 14 ports within the STS. 
However, 14 VT1.5s are not utilized.

— —

DS3-12, DS3N-12, DS3-12E, DS3N-12E 12 —

DS3XM-6 6 —

DS3I-N-12 12 1 per port

EC1-12 12 —

OC3 IR 4/STM1 4 3 per port

OC3-8 8 3 per port

OC12 IR/STM4 SH 1310
OC12 LR/STM4 LH 1310
OC12 LR/STM4 LH 1550

— 12

OC12 IR/STM4 SH 1310-4 4 12 per port

All OC-48 cards (includes ML-Series card) — 48

All OC-192 cards — 192

FC_MC-42

2. For CCAT circuits, the FC_MC-4 card maps STS-24c or STS-48c to a port. For VCAT, 
the FC_MC-4 card maps STS3c-8v to a port. 

4 —

Purpose This procedure verifies that the ONS 15454 network is ready for circuit 
provisioning. 

Tools/Equipment None

Prerequisite Procedures Chapter 6, “Turn Up Network”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Verify node accessibility. In the network view, all node icons must be either green, yellow, orange, or red.

If all network nodes do not appear after a few minutes, or if a node icon is gray with an IP address under 
it, do not continue. Look at the Net box in the lower right corner of the window. If it is gray, log in again, 
making sure not to check the Disable Network check box in the CTC Login dialog box. If problems 
persist, see Chapter 6, “Turn Up Network” to review the network turn-up procedure appropriate for your 
network topology, or refer to the Cisco ONS 15454 Troubleshooting Guide for troubleshooting 
procedures.

Step 4 Verify DCC connectivity. All nodes must be connected by green lines. If lines are missing or gray in 
color, do not continue. See Chapter 6, “Turn Up Network” and follow the network turn-up procedure 
appropriate for your network topology. Verify that all nodes have DCC connectivity before continuing.

Step 5 Click the Alarms tab to view alarm descriptions. Investigate and resolve, if necessary, all critical (red 
node icon) or major (orange node icon) alarms. Refer to the Cisco ONS 15454 Troubleshooting Guide to 
resolve alarms before continuing.

Step 6 From the View menu, choose Go to Home View. Verify that the node is provisioned according to your 
site or engineering plan:

a. View the cards in the shelf map. Verify that the ONS 15454 cards appear in the specified slots.

b. Click the Provisioning > General tabs. Verify that the node name, contacts, date, time, and Network 
Time Protocol/Simple Network Time Protocol (NTP/SNTP) server IP address (if used) are correctly 
provisioned. If needed, make corrections using the “NTP-A25 Set Up Name, Date, Time, and 
Contact Information” procedure on page 4-7.

c. Click the Network tab. Verify that the IP address, Subnet Mask, Default Router, Prevent LCD IP 
Config, and Gateway Settings are correctly provisioned. If not, make corrections using the 
“NTP-A169 Set Up CTC Network Access” procedure on page 4-9.

d. Click the Protection tab. Verify that protection groups are created as specified in your site plan. If 
the protection groups are not created, complete the “NTP-A170 Create Protection Groups” 
procedure on page 4-26.

e. If the node is in a BLSR, click the BLSR tab. (If the node is not in a BLSR, continue with Step f.) 
Verify that the following items are provisioned as specified in your site plan: 

• BLSR type (2-fiber or 4-fiber) 

• BLSR ring ID and node IDs

• Ring reversion time

• East and west card assignments 

• 4-fiber BLSRs: span reversion and east/west protect card assignments

If you need to make corrections, see the “NTP-A40 Provision BLSR Nodes” procedure on page 6-15 
for instructions.

f. Click the Security tab. Verify that the users and access levels are provisioned as specified. If not, 
see the “NTP-A30 Create Users and Assign Security” procedure on page 4-4 to correct the 
information.

g. If simple network management protocol (SNMP) is used, click the SNMP tab and verify the trap 
and destination information. If the information is not correct, see the “NTP-A87 Change SNMP 
Settings” procedure on page 12-33 to correct the information. 
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h. Click the DCC/GCC/OSC tab. Verify that DCCs were created to the applicable OC-N slots and 
ports (time-division multiplexing [TDM] nodes) or Optical Service Channel (OSC) slots and ports 
(DWDM nodes). If DCCs were not created for the appropriate OC-N or OSC slots and ports, see 
Chapter 6, “Turn Up Network” and complete the turn-up procedure appropriate for your network 
topology.

i. Click the Timing tab. Verify that timing is provisioned as specified. If not, use the “NTP-A85 
Change Node Timing” procedure on page 12-23 to make the changes.

j. Click the Alarm Profiles tab. If you provisioned optional alarm profiles, verify that the alarms are 
provisioned as specified. If not, see the “NTP-A71 Create, Download, and Assign Alarm Severity 
Profiles” procedure on page 9-17 to change the information.

k. Verify that the network element defaults listed in the status area of the node view window are 
correct.

Step 7 Repeat Step 6 for each node in the network.

Step 8 Complete the appropriate circuit creation procedure from the NTP list in the “NoteThe terms 
"Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms do not 
refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. Rather, 
these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path 
protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.” 
section on page 8-1.

Stop. You have completed this procedure.

NTP-A181 Create an Automatically Routed DS-1 Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15454 
network.

Purpose This procedure creates an automatically routed DS-1 circuit, meaning that 
CTC chooses the circuit route based on the parameters you specify and on 
the software version. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Number of Circuits—Type the number of DS-1 circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same slot and sequential port numbers, you can use 
Auto-ranged to create the circuits automatically. 

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
Circuits field. Auto-ranging creates identical (same source and destination) sequential circuits 
automatically. Uncheck the box if you do not want CTC to create sequential circuits automatically.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-1):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—VT1.5 is the default. You cannot change it. 

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms are generated if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement (SLA) number. Otherwise, leave the field set to zero. 
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• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC displays only 
protected cards and ports as source and destination choices.

Figure 8-1 Setting Circuit Attributes for a DS-1 Circuit

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11. Otherwise, continue with the next step.

Step 9 Click Next. 

Step 10 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 8-12.

Step 11 In the Circuit Routing Preferences area (Figure 8-2), choose Route Automatically. Two options are 
available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box if you want to specify nodes and spans to 
include or exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box if you want to review and edit the circuit 
route before the circuit is created.

Figure 8-2 Setting Circuit Routing Preferences for a DS-1 Circuit

Step 12 To set the circuit path protection, complete one of the following:
8-8
Cisco ONS 15454 Procedure Guide, R4.6

December 2004



 

Chapter 8      Create Circuits and VT Tunnels
NTP-A181 Create an Automatically Routed DS-1 Circuit
• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. CTC creates a fully protected circuit route based on the path diversity option you choose. 
Fully protected paths might or might not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Caution Circuits routed on BLSR protection channels are not protected. They are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection dual 
ring interconnect (DRI), check the Dual Ring Interconnect check box.

Step 15 If you selected Using Required Nodes/Spans in Step 11, complete the following substeps. If not, 
continue with Step 18.

a. Click Next.

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists and click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 16 Click Next. In the Create area of the VT Circuit Options panel, choose one of the following:

• VT tunnel on transit nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 
28 VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT 
circuits from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for 
more information.

• VT aggregation point—This option is available if the DS-1 circuit source or destination is on an 
EC-1, DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. VT aggregation points 
(VAPs) collect DS-1s on an STS for handoff to non-ONS 15454 networks or equipment, such as an 
IOF, switch, or digital access and cross-connect system (DACS). It allows VT1.5 circuits to be 
routed through the node using one STS connection on the cross-connect card matrix rather than 
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multiple VT connections on the cross-connect card VT matrix. If you want to aggregate the DS-1 
circuit you are creating with others onto an STS for transport outside the ONS 15454 network, 
choose one of the following:

– Circuit source is STS grooming node—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Circuit destination is STS grooming node—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This is the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 17 If you chose VT aggregation point, complete the following substeps. If not, continue with Step 18.

a. Click Next.

b. In the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 18 If you selected Review Route Before Creation in Step 11, complete the following substeps. If not, 
continue with Step 19. 

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A182 Create a Manually Routed DS-1 Circuit” procedure on page 8-13.

Step 19 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto-ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box appears. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto-ranging. After completing the circuit(s), the Circuits window 
appears.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat Steps 5 
through 19 for each additional circuit. After completing the circuit(s), the Circuits window appears.

Step 20 In the Circuits window, verify that the new circuit(s) appear in the circuits list.

Step 21 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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DLP-A314 Assign a Name to a Port

Step 1 Double-click the card that has the port you want to provision.

Step 2 Click the Provisioning tab.

Step 3 Click the Port Name column for the port number you are assigning a name.

Step 4 Type the port name. 

The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-A218 Provision Path Protection Selectors During Circuit Creation

Step 1 In the path protection area of the Circuit Attributes panel, set the path protection path selectors:

• Provision working go and return on primary path—Check this box to route the working path on one 
fiber pair and the protect path on a separate fiber pair. This feature only applies to bidirectional path 
protection circuits. 

• Revertive—Check this box if you want traffic to revert to the working path when the conditions that 
diverted it to the protect path are repaired. If you do not choose Revertive, traffic remains on the 
protect path after the switch.

• Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time 
from the drop-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the 
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when 
conditions causing the switch are cleared.

Purpose Use this task to assign a name to a port on any ONS 15454 card. 

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions path protection selectors during circuit creation. Use 
this task only if the circuit will be routed on a path protection.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Circuit Attributes panel must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• SF threshold—For STS circuits, set the path protection path-level signal failure bit error rate (BER) 
thresholds. Unavailable for VT circuits.

• SD threshold—For STS circuits, set the path protection path-level signal degrade BER thresholds. 
Unavailable for VT circuits.

• Switch on PDI-P—For STS circuits, check this box if you want traffic to switch when an STS 
payload defect indicator is received. Unavailable for VT circuits.

Step 2 Return to your originating procedure (NTP).

DLP-A95 Provision a DS-1 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu, choose the node where the source will originate.

Step 2 From the Slot drop-down menu, choose the slot containing the DS1-14, DS1N-14, or DS3XM-6 card 
where the circuit will originate (Figure 8-3). 

Figure 8-3 Defining the Circuit Source on a DS-1 Card

Step 3 Only if you chose DS3XM-6 as the card, choose the port from the Port drop-down menu.

Step 4 From the DS-1 drop-down menu, choose the source DS-1.

Purpose This task provisions an electrical circuit source and destination for a DS-1 
circuit. This task does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 4 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 6. 

Step 6 Click Next. 

Step 7 From the Node drop-down menu, choose the destination (termination) node.

Step 8 From the Slot drop-down menu, choose the slot containing the destination card. The destination is 
typically a DS-1 card. You can also choose an OC-N card to map the DS-1 to a VT1.5 for OC-N 
transport.

Step 9 Depending on the destination card, choose the destination port, STS, VT, or DS1 from the drop-down 
menus that appear based on the card selected in Step 8. See Table 8-2 on page 8-3 for a list of valid 
options. CTC does not display ports, STSs, VTs, or DS1s already used by other circuits. If another user 
and you working on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one 
of you receives a Path in Use error and is unable to complete the circuit. The user with the incomplete 
circuit needs to choose new destination parameters.

Step 10 If you need to create a secondary destination, for example, a path protection bridge/selector circuit exit 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 7 through 9 
to define the secondary destination. 

Step 11 Click Next. 

Step 12 Return to your originating procedure (NTP).

NTP-A182 Create a Manually Routed DS-1 Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15454 
network.

• Number of Circuits—Type the number of DS-1 circuits you want to create. The default is 1. 

Purpose This procedure creates a DS-1 circuit and allows you to provision the 
circuit route. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—Applies to automatically routed circuits only. If you entered more than 1 in the 
Number of Circuits field, uncheck this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-1 on page 8-8):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC shows only 
protected cards and ports as source and destination choices.

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11. Otherwise, continue with the next step.
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Step 9 Click Next. 

Step 10 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 8-12.

Step 11 In the Circuit Routing Preferences area (Figure 8-2 on page 8-8), uncheck Route Automatically. 

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 17.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 17.

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
a Node-Diverse Path option: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired— Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
check the Dual Ring Interconnect check box.

Step 15 Click Next. In the Create area of the VT Circuit Options panel, choose one of the following:

• VT tunnel on transit nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for more 
information.

• VT aggregation point—This option is available if the DS-1 circuit source or destination is on an 
EC-1, DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. VT aggregation points 
(VAPs) collect DS-1s on an STS for handoff to non-ONS 15454 networks or equipment, such as an 
IOF, switch, or DACS. It allows VT1.5 circuits to be routed through the node using one STS 
connection on the cross-connect card matrix rather than multiple VT connections on the 
cross-connect card VT matrix. If you want to aggregate the DS-1 circuit you are creating with others 
onto an STS for transport outside the ONS 15454 network, choose one of the following:

– Circuit source is STS grooming node—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Circuit destination is STS grooming node—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.
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• None—Choose this option if you do not want to create a VT tunnel or a VAP. This is the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 16 If you chose VT aggregation point, complete the following substeps. If not, continue with Step 18.

a. Click Next.

b. In the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 17 Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit. The circuit 
source node is selected. Green arrows pointing from the source node to other network nodes indicate 
spans that are available for routing the circuit. 

Step 18 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 8-16 for the DS-1 circuit 
you are creating. 

Step 19 Click Finish. CTC compares your manually provisioned circuit route with the specified path diversity 
option you chose in Step 13. If the path does not meet the specified path diversity requirement, CTC 
displays an error message and allows you to change the circuit path. If you entered more than 1 in the 
Number of Circuits field, the Circuit Creation dialog box appears so you can create the remaining 
circuits. Repeat Steps 5 through 19 for each additional circuit.

Step 20 When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you created 
are correct.

Step 21 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-A96 Provision a DS-1 or DS-3 Circuit Route

Step 1 In the Route Review and Edit area of the Circuit Creation wizard, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. In the Selected Span area, the From and To fields provide span information. The 
source STS and VT (DS-1 circuit only) appear. Figure 8-4 shows a DS-1 circuit example.

Purpose This task provisions the circuit route for manually routed DS-1 or DS-3 
circuits. This task does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Route Review and Edit panel must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 8-4 Manually Routing a DS-1 Circuit

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with Step 4.

Step 4 If you want to change the source VT for DS-1 circuits, adjust the Source VT field; otherwise, continue 
with Step 5.

Note VT is gray (unavailable) for DS-3 circuits.

Step 5 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue. 

Step 6 If the Fully Protect Path check box is checked in the Circuit Routing Preferences panel, you must:

• Add two spans for all path protection or unprotected portions of the circuit route from the source to 
the destination. If the Dual Ring Interconnect check box is checked, you must also add bidirectional 
spans between the DRI nodes. To do this, click a DRI node, then double-click the arrow pointing to 
the adjacent DRI node to create a bidirectional span.

• Add one span for all BLSR or 1+1 portions of route from the source to the destination. 

Step 7 Repeat Steps 2 through 6 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. 

Step 8 Return to your originating procedure (NTP).
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NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple 
Drops

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose VT.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-5):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Uncheck for this circuit.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Purpose This procedure creates a unidirectional DS-1 circuit with multiple drops 
(destinations). This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed to protect drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC displays only 
protected cards as source and destination choices.

Figure 8-5 Setting Circuit Attributes for a Unidirectional DS-1 Circuit

Step 8 Click Next. 

Step 9 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 8-12.

Step 10 In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically is 
not selected, the Using Required Nodes/Spans and Review Route Before Circuit Creation check boxes 
are unavailable.
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Step 11 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 17.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 17. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 12 If you selected Fully Protected Path in Step 11 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 13 If you selected Fully Protected Path in Step 11 and the circuit will be routed on a path protection DRI, 
click the Dual Ring Interconnect check box.

Step 14 Click Next. In the Create area of the VT Circuit Options panel, choose one of the following:

• VT tunnel on transit nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 
28 VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT 
circuits from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for 
more information.

• VT aggregation point—This option is available if the DS-1 circuit source or destination is on an 
EC-1, DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. VT aggregation points 
(VAPs) collect DS-1s on an STS for handoff to non-ONS 15454 networks or equipment, such as an 
IOF, switch, or DACS. It allows VT1.5 circuits to be routed through the node using one STS 
connection on the cross-connect card matrix rather than multiple VT connections on the 
cross-connect card VT matrix. If you want to aggregate the DS-1 circuit you are creating with others 
onto an STS for transport outside the ONS 15454 network, choose one of the following:

– Circuit source is STS grooming node—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Circuit destination is STS grooming node—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This is the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 15 If you chose VT aggregation point, complete the following substeps. If not, continue with Step 18.

a. Click Next.
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b. In the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 16 Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit manually. 
The circuit source node is selected. Green arrows pointing from the source node to other network nodes 
indicate spans that are available for routing the circuit. 

Step 17 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 8-16 for the DS-1 circuit 
you are creating. 

Step 18 Click Finish. CTC completes the circuit and the Circuits window appears.

Step 19 In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 20 Click Edit (or double-click the circuit row). The Edit Circuit window appears with the General tab 
selected. 

All nodes in the DCC network appear on the network map. Circuit source and destination information 
appears under the source and destination nodes. To see a detailed view of the circuit, click Show 
Detailed Map. To rearrange a node icon, select the node, press Ctrl, then drag and drop the icon to the 
new location.

Step 21 In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 22 Click Create.

Step 23 In the Define New Drop dialog box, create the new drop:

a. Node—Choose the target node for the circuit drop. 

b. Slot—Choose the target card and slot.

c. Port, STS, VT, or DS1—Choose the port, STS, VT, or DS1 from the Port, STS, VT, or DS1 
drop-down menus. The card you chose in Step b determines the fields that appear. See Table 8-2 on 
page 8-3 for a list of options.

d. The routing preferences for the new drop match those of the original circuit. However, if the 
following options are available, you can modify them: 

• If the original circuit was routed on a protected path protection path, you can change the nodal 
diversity options: Nodal Diversity Required, Nodal Diversity Desired, or Link Diversity Only. 
See Step 12 for the option descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access option 
is available. See Step 11 for a description of the PCA option.

e. If you want to change the circuit state, choose the circuit state from the Target Circuit State 
drop-down menu. The state chosen applies to the entire circuit. 

f. Check Apply to drop ports if you want to apply the state chosen in the Target Circuit State to the 
circuit source and destination drops.

g. Click Finish. The new drop appears in the Drops list.

Step 24 If you need to create additional drops for the circuit, repeat Steps 22 and 23 to create the additional drops.

Step 25 Click Close. The Circuits window appears.

Step 26 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear repeat Steps 5 through 25, making sure all options are provisioned correctly.

Step 27 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.
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Stop. You have completed this procedure.

NTP-A184 Create an Automatically Routed DS-3 Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15454 
network.

• Number of Circuits—Type the number of DS-3 circuits you want to create. The default is 1. If you 
are creating multiple circuits with sequential source and destination ports, you can use Auto-ranged 
to create the circuits automatically. 

• Auto-ranged—This box is automatically selected if you enter more than 1 in the Number of Circuits 
field. Leave selected if you are creating multiple DS-3 circuits with the same source and destination 
and you want CTC to create the circuits automatically. Uncheck the box if you do not want CTC to 
create sequential circuits automatically.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-6):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose STS-1. For circuits on the DS3i-N-12 card, choose STS-3c. This sets a port group for 
ports 1, 4, 7, and 10 using 3 ports at any given time.

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure creates an automatically routed DS-3 circuit. CTC routes 
the circuit automatically based on circuit creation parameters and the 
software version. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC provides only 
protected cards and ports as source and destination choices.

Figure 8-6 Setting Circuit Attributes for a DS-3 Circuit

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 8-26.

Step 11 In the Circuit Routing Preferences area (Figure 8-7), choose Route Automatically. Two options are 
available; choose either, both, or none based on your preferences:
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• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created.

Figure 8-7 Setting Circuit Routing Preferences for a DS-3 Circuit

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. CTC creates a fully protected circuit route based on the path diversity option you choose. 
Fully protected paths might or might not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
check the Dual Ring Interconnect check box.
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Step 15 If you selected Using Required Nodes/Spans in Step 11, complete the following substeps; otherwise, 
continue with Step 16:

a. Click Next. 

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans determines the circuit 
sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node from the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Note If a node or span stays gray, that node or span is required.

Step 16 If you selected Review Route Before Creation in Step 11, complete the following substeps; otherwise, 
continue with Step 17.

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A185 Create a Manually Routed DS-3 Circuit” procedure on page 8-27.

Step 17 Click Finish. One of the following actions occurs based on the circuit properties you selected:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto-ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box appears. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto-ranging. After completing the circuit(s), the Circuits window 
appears.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat Steps 5 
through 17 for each additional circuit. After completing the circuit(s), the Circuits window appears.

Step 18 In the Circuits window, verify that the circuit(s) you just created appear in the circuits list.

Step 19 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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DLP-A208 Provision a DS-3 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu, choose the node where the source will originate.

Step 2 From the Slot drop-down menu, choose the slot containing the DS-3 card where the circuit will originate. 
If you are configuring a DS-3 circuit with a transmux card, choose the DS3XM-6 card.

Step 3 From the Port drop-down menu, choose the source DS-3 or DS3XM-6 card as appropriate.

Step 4 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 3 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 5. 

Step 5 Click Next. 

Step 6 From the Node drop-down menu, choose the destination (termination) node.

Step 7 From the Slot drop-down menu, choose the slot containing the destination card. The destination is 
typically a DS3XM-6 or DS-3 card. You can also choose an OC-N card to the map DS-3 circuit to an 
STS.

Step 8 Depending on the destination card, choose the destination port or STS from the submenus that appear 
based on the card selected in Step 2. See Table 8-2 on page 8-3 for a list of valid options. CTC does not 
display ports, STSs, VTs, or DS1s if they are already in use by other circuits. If you and a user working 
on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one of you receives 
a Path in Use error and is unable to complete the circuit. The user with the incomplete circuit needs to 
choose new destination parameters.

Step 9 If you need to create a secondary destination, for example, a path protection bridge/selector circuit exit 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 6 through 8 
to define the secondary destination. 

Step 10 Click Next. 

Step 11 Return to your originating procedure (NTP).

Purpose This task provisions an electrical circuit source and destination for a DS-3 
circuit.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A185 Create a Manually Routed DS-3 Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 3.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 4.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15454 
network.

• Number of Circuits—Type the number of DS-3 circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically routed circuits only. If you entered more than 1 in the 
Number of Circuits field, uncheck this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-5 on page 8-19):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave this field blank, CTC assigns a default name to the circuit.

• Size—Choose STS-1. For circuits on the DS3i-N-12 card, choose STS-3c. This sets a port group for 
ports 1, 4, 7, and 10 using 3 ports at any given time.

• Bidirectional—Leave this field checked (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Purpose This procedure creates a DS-3 circuit and allows you to provision the 
circuit route. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this check box, CTC 
provides only protected cards as source and destination choices.

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 8-26.

Step 11 In the Circuit Routing Preferences area (Figure 8-7 on page 8-24), uncheck Route Automatically. 

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15.

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.
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Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
click the Dual Ring Interconnect check box.

Step 15 Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit manually. 
The green arrows pointing from the selected node to other network nodes indicate spans that are 
available for routing the circuit. 

Step 16 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 8-16 for the DS-3 you 
are creating.

Step 17 Click Finish. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box 
appears so you can create the remaining circuits. Repeat Steps 5 through 17 for each additional circuit.

Step 18 When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you created 
appear in the window.

Step 19 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple 
Drops

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS. 

• Number of Circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-8):

Purpose This procedure creates a unidirectional DS-3 circuit with multiple drops. 
This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose STS-1. For circuits on the DS3i-N-12 card, choose STS-3c.

• Bidirectional—Uncheck for this circuit.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this check box, CTC 
provides only protected cards as source and destination choices.
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Figure 8-8 Setting Circuit Attributes for a Unidirectional DS-3 Circuit

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 8-26.

Step 11 Uncheck Route Automatically. When Route Automatically is not selected, the Using Required 
Nodes/Spans and Review Route Before Circuit Creation check boxes are unavailable. 

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
check the Dual Ring Interconnect check box.
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Step 15 Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit manually. 
The circuit source node is selected. Green arrows pointing from the source node to other network nodes 
indicate spans that are available for routing the circuit.

Step 16 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 8-16 for the DS-3 you 
are creating.

Step 17 Click Finish. After completing the circuit, the Circuits window appears.

Step 18 In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search radio buttons become active.

Step 19 Click Edit. The Edit Circuit window appears with the General tab selected. All nodes in the DCC 
network appear on the network map. Circuit source and destination information appears under the source 
and destination nodes. To see a detailed view of the circuit, click Show Detailed Map. You can rearrange 
the node icons by selecting the node with the left mouse button while simultaneously pressing Ctrl, then 
dragging the icon to the new location.

Step 20 In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 21 Click Create.

Step 22 In the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS—Choose the port and/or STS from the Port and STS drop-down menus. The card selected 
in Step b determines whether port, STS, or both appear. See Table 8-2 on page 8-3 for a list of 
options.

d. The routing preferences for the new drop match those of the original circuit. However, if the 
following options are available, you can modify them: 

• If the original circuit was routed on a protected path protection path, you can change the nodal 
diversity options: Nodal Diversity Required, Nodal Diversity Desired, or Link Diversity Only. 
See Step 13 for option descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access option 
is available. See Step 12 for a description of the PCA option.

e. If you want to change the circuit state, choose the circuit state from the Target Circuit State 
drop-down menu. The state chosen applies to the entire circuit. 

f. Check Apply to drop ports if you want to apply the state chosen in the Target Circuit State to the 
circuit source and destination drops.

g. Click Finish. The new drop appears in the Drops list.

Step 23 If you need to create additional drops for the circuit, repeat Steps 21 and 22 to create the additional drops.

Step 24 Click Close. The Circuits window appears.

Step 25 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear, repeat Steps 22 through 24, making sure all options are provisioned correctly.

Step 26 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-A133 Create an Automatically Routed VT Tunnel

Note VT tunnels allow VT circuits to pass through intermediary ONS 15454s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the “Circuits and Tunnels” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you want to create the VT 
tunnel. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, choose VT Tunnel from the Circuit Type list. 

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-9):

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the tunnel 
is out of service.

– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and allows loopbacks to be performed on the 
tunnel. Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the 
state to IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit 
State” task on page 11-13.

• Apply to drop ports—Unavailable for VT tunnels.

• Inter-domain (UCP) SLA—If the tunnel will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

Purpose This procedure creates an automatically routed VT tunnel from source to 
destination nodes.This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 8-9 Setting Attributes for a VT Tunnel

Step 8 Click Next. 

Step 9 In the Circuit Source area, choose the node where the VT tunnel will originate from the Node drop-down 
menu. 

Step 10 Click Next.

Step 11 In the Circuit Destination area, choose the node where the VT tunnel will terminate from the Node 
drop-down menu.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.

• Review Route Before Creation—Check this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 14 If you selected Using Required Nodes/Spans in Step 13:

a. Click Next.

b. In the Circuit Route Constraints area, click a span on the VT tunnel map.

c. Click Include to include the node or span in the VT tunnel. Click Exclude to exclude the node or 
span from the VT tunnel. The order in which you choose included nodes and spans sets the VT 
tunnel sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the VT tunnel route. To change the tunnel routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 15 If you selected Review Route Before Creation in Step 13:

a. Click Next.

b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.
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Step 16 Click Finish. The Circuits window appears.

Step 17 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Stop. You have completed this procedure.

NTP-A134 Create a Manually Routed VT Tunnel

Note VT tunnels allow VT circuits to pass through intermediary ONS 15454s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the “Circuits and Tunnels” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the VT 
tunnel. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, choose VT Tunnel from the Circuit Type list.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-9 on page 8-34):

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the circuit 
is out of service.

Purpose This procedure creates a manually routed VT tunnel from source to 
destination nodes. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and allows loopbacks to be performed. Use 
OOS-MT for testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” task on 
page 11-13.

• Apply to drop ports—Unavailable for VT tunnels.

• Inter-domain (UCP) SLA—If the tunnel will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

Step 8 Click Next. 

Step 9 In the Circuit Source area, choose the node where the VT tunnel will originate from the Node drop-down 
menu. 

Step 10 Click Next.

Step 11 In the Circuit Destination area, choose the node where the VT tunnel will terminate from the Node 
drop-down menu. 

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, uncheck Route Automatically.

Step 14 Click Next. In the Route Review and Edit area, node icons appear so you can route the tunnel. The circuit 
source node is selected. Green arrows pointing from the source node to other network nodes indicate 
spans that are available for routing the tunnel. 

Step 15 Complete the “DLP-A219 Provision a VT Tunnel Route” task on page 8-36 for the tunnel you are 
creating. The Circuits window appears.

Step 16 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Stop. You have completed this procedure.

DLP-A219 Provision a VT Tunnel Route

Step 1 In the Circuit Creation wizard in the Route Review and Edit area, click the source node icon if it is not 
already selected. Arrows indicate the available spans for routing the tunnel from the source node.

Step 2 Click the arrow of the span you want the VT tunnel to travel. The arrow turns white. In the Selected Span 
area, the From and To fields show the slot and port that will carry the tunnel. The source STS appears. 
Figure 8-10 shows an example.

Purpose This task provisions the route for a manually routed VT tunnel.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Route Review and Edit panel must be open. 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 8-10 Manually Routing a VT Tunnel

Step 3 If you want to change the source STS, change it in the Source STS field; otherwise, continue with the 
next step.

Step 4 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 3 and 4 until the tunnel is provisioned from the source to the destination node through all 
intermediary nodes.

Step 6 Return to your originating procedure (NTP).

NTP-A187 Create a VT Aggregation Point

Note VT aggregation points can be created for circuits on BLSR, 1+1, or unprotected nodes. They cannot be 
created for circuits on path protection nodes.

Purpose This procedure creates a VT aggregation point (VAP). VAPs allow multiple 
DS-1 (VT1.5) circuits to be aggregated on a single STS on an OC-N, EC-1, 
or DS3XM-6 card. VAPs allow multiple VT1.5 circuits to pass through 
cross-connect cards without utilizing resources on the cross-connect card 
VT matrix. This procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The maximum number of VAPs that you can create depends on the node protection topology and number 
of VT1.5 circuits that terminate on the node. Assuming no other VT1.5 circuits terminate at the node, 
the maximum number of VAPs that you can terminate at one node is 8 for 1+1 protection and 12 for 
BLSR protection. 

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the VT 
aggregation point. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, choose VT Aggregation Point from the Circuit Type list.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-11):

• Name—Assign a name to the VT aggregation point. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the VAP.

• Size—Unavailable for VAPs.

• Bidirectional—Unavailable for VAPs.

• State—Choose a service state to apply to the VAP:

– IS—The VAP is in service.

– OOS—The VAP is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VAP is in service when it receives a valid signal; until then, the tunnel is out 
of service.

– OOS-MT—The VAP is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the VAP. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Uncheck this box.

• Inter-domain (UCP) SLA—If the VAP will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 
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Figure 8-11 Setting Attributes for a VT Aggregation Point

Step 8 Click Next. 

Step 9 In the Circuit Source area, choose the source node, slot, port, and STS for the VAP. The VAP source is 
where the DS-1 (VT1.5) circuits will be aggregated into a single STS. The VAP destination is where the 
DS-1 circuits originate.

a. From the Node drop-down menu, choose the node where the VAP will originate.

b. From the Slot drop-down menu, choose the slot containing the OC-N, EC-1 or DS3XM-6 card where 
the VAP will originate. 

c. Choose either the port or STS:

• If you choose an EC-1 or DS3XM-6 card, from the Port drop-down menu, choose the source 
port.

• If you choose an OC-N card, from the STS drop-down menu, choose the source STS.

Step 10 Click Next.

Step 11 In the Circuit Destination area, choose the node where the VT circuits aggregated by the VAP will 
terminate from the Node drop-down menu.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.

• Review Route Before Creation—Check this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 14 If you selected Using Required Nodes/Spans in Step 13:

a. Click Next.

b. In the Circuit Route Constraints area, click a span on the VAP map.

c. Click Include to include the node or span in the VAP. Click Exclude to exclude the node or span 
from the VAP. The sequence in which you choose the nodes and spans sets the VAP sequence. Click 
spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.
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e. Review the VAP route. To change the tunnel routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 15 If you selected Review Route Before Creation in Step 13:

a. Click Next.

b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.

Step 16 Click Finish. The Circuits window appears.

Step 17 Verify that the VAP you just created appears in the circuits list. VAPs are identified in the Type column.

Stop. You have completed this procedure.

NTP-A135 Test Electrical Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you want to test the 
electrical circuits. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab. 

Purpose This procedures tests DS-1 and DS-3 circuits. This procedure does not 
apply to DWDM-only nodes.

Tools/Equipment A test set and all appropriate cables

Prerequisite Procedures This procedure assumes you completed a facility loopback tests on the 
fibers and cables from the source and destination ONS 15454s to the DSX, 
and that you created a circuit using one of the following procedures:

NTP-A181 Create an Automatically Routed DS-1 Circuit, page 8-6

NTP-A182 Create a Manually Routed DS-1 Circuit, page 8-13

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, 
page 8-18

NTP-A184 Create an Automatically Routed DS-3 Circuit, page 8-22

NTP-A185 Create a Manually Routed DS-3 Circuit, page 8-27

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, 
page 8-29

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 4 Set the circuit and circuit ports to the maintenance state (OOS-MT). Take note of the original state 
because you will return the circuit to that state later.

a. Click the circuit you want to test, then choose Circuits > Set Circuit State from the Tools menu.

b. In the Set Circuit State dialog box, choose OOS-MT from the Target Circuit State drop-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 5 Set the source and destination DS-1 card line length:

a. In network view, double-click the source node.

b. Double-click the circuit source card and click the Provisioning > Line tabs.

c. From the circuit source port Line Length drop-down menu, choose the line length for the distance 
(in feet) between the DSX (if used) or circuit termination point and the source ONS 15454.

d. Click Apply.

e. From the View menu, choose Go to Network View.

f. Repeat Steps a through e for the destination port line length.

Step 6 Attach loopback cables to the circuit destination card:

a. Verify the integrity of the loopback cable by looping the test set transmit (Tx) connector to the test 
set receive (Rx) connector. If the test set does not run error-free, check the cable for damage and 
check the test set to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the Tx connector to the Rx connector 
of the port. 

Step 7 Attach loopback cables to the circuit source node:

a. Verify the integrity of loopback cable by looping the test set Tx connector to the test set Rx 
connector. If the test set does not run error-free, check the cable for damage and check the test set 
to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the test set to the circuit source port. 
Connect the Tx port of the test set to the circuit Rx port, and the test set Rx port to the circuit Tx port. 

Step 8 Configure the test set for the ONS 15454 card that is the source of the circuit you are testing:

• DS-1—If you are testing an unmultiplexed DS-1, you must have a DSX-1 panel or a direct DS-1 
interface into the ONS 15454. Set the test set for DS-1. For information about configuring your test 
set, consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a multiplexed DS3. After you choose 
multiplexed DS-3, choose the DS-1 to test on the multiplexed DS-3. For information about 
configuring your test set, consult your test set user guide.

• EC-1—If you are testing a DS-1 on an EC1 card, you must have a DSX-3 panel or a direct DS-3 
interface to the ONS 15454. Set the test set for an STS-1. After you choose STS-1, choose the DS1 
to test the STS-1. For information about configuring your test set, consult your test set user guide.

Step 9 Verify that the test set shows a clean signal. If a clean signal does not appear, repeat Steps 2 through 8 
to make sure the test set and cabling is configured correctly. 

Step 10 Inject errors from the test set. Verify that the errors appear at the source and destination nodes. 
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Step 11 Clear the PM counts for the ports that you tested. See the “DLP-A349 Clear Selected PM Counts” task 
on page 10-8 for instructions.

Step 12 Return the circuit and circuit ports to the state they were in at the beginning of the test:

a. Click the circuit you want to test, then choose Circuits > Set Circuit State from the Tools menu.

b. In the Set Circuit State dialog box, choose IS (in service), OOS (out of service) or OOS-AINS (auto 
in service) from the Target Circuit State drop-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 13 Perform the protection switch test appropriate to the SONET topology:

• For path protections, complete the “DLP-A94 Path Protection Switching Test” task on page 6-40.

• For BLSRs complete the “DLP-A91 BLSR Switch Test” task on page 6-26.

Step 14 Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time. For 
information about configuring your test set for BERT, see your test set user guide.

Step 15 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results, see your test set user guide. 

Stop. You have completed this procedure.

NTP-A188 Create an Automatically Routed OC-N Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS. 

• Number of Circuits—Type the number of OC-N circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same source and destination, you can use auto-ranging to 
create the circuits automatically. 

Purpose This procedure creates an automatically routed bidirectional or 
unidirectional OC-N circuit, including STS-1 and concatenated STS-3c, 
STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, or STS-192c speeds. This 
procedure does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—This check box is automatically selected when you enter more than 1 in the Number 
of Circuits field. Leave this check box selected if you are creating multiple OC-N circuits with the 
same source and destination and you want CTC to create the circuits automatically. Uncheck the box 
if you do not want CTC to create the circuits automatically.

Step 6 Click Next.

Step 7 Define the circuit attributes (Figure 8-12 on page 8-44):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the OC-N circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, 
STS-48c, or STS-192c.

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protected drops only, that 
is, to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this check box, CTC 
provides only protected cards as source and destination choices.
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Figure 8-12 Setting Circuit Attributes for an OC-N Circuit

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A97 Provision an OC-N Circuit Source and Destination” task on page 8-50 for the 
OC-N circuit you are creating.

Step 11 In the Circuit Routing Preferences area (Figure 8-13), choose Route Automatically. Two options are 
available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created.

Figure 8-13 Setting Circuit Routing Preferences for an OC-N Circuit

Step 12 To set the circuit path protection, complete one of the following:
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• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. CTC creates a fully protected circuit route based on the path diversity option you choose. 
Fully protected paths might or might not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
click the Dual Ring Interconnect check box.

Step 15 If you selected Using Required Nodes/Spans in Step 11, complete the following substeps. If not, 
continue with Step 16:

a. Click Next.

b. In the Circuit Route Constraints area, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 16 If you selected Review Route Before Creation in Step 11, complete the following substeps; otherwise, 
continue with Step 17:

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A189 Create a Manually Routed OC-N Circuit” procedure on page 8-47 to assign the circuit 
route yourself.

Step 17 Click Finish. One of the following occurs, based on the circuit properties you provisioned in the Circuit 
Creation dialog box:
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• If you entered more than 1 in the number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of Circuits. If auto-ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable on the source or 
destination, a dialog box appears. Set the new source or destination for the remaining circuits, then 
click Finish to continue auto-ranging. After completing the circuit(s), the Circuits window appears.

• If you entered more than 1 in the number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat 
Steps 5 through 17 for each additional circuit. After completing the circuit(s), the Circuits window 
appears.

Step 18 In the Circuits window, verify that the circuit(s) you created appear in the circuits list.

Step 19 Complete the “NTP-A62 Test OC-N Circuits” procedure on page 8-54. Skip this step if you built a test 
circuit.

Stop. You have completed this procedure.

DLP-A98 Provision an OC-N Circuit Route

Step 1 In the Circuit Creation wizard in the Route Review and Edit area, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. In the Selected Span area, the From and To fields provide span information. The 
source STS appears. Figure 8-14 shows an example.

Purpose This task provisions the circuit route for manually-routed OC-N circuits.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 8-14 Manually Routing an OC-N Circuit

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with Step 4.

Note VT is gray for OC-N circuits.

Step 4 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 2 through 4 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. If Fully Protect Path is checked on the Circuit Routing Preferences panel, you 
must:

• Add two spans for all path protection or unprotected portions of the circuit route from the source to 
the destination

• Add one span for all BLSR or 1+1 portions of route from the source to the destination

Step 6 Return to your originating procedure (NTP).

NTP-A189 Create a Manually Routed OC-N Circuit

Purpose This procedure creates a manually routed, bidirectional or unidirectional, 
OC-N circuit, including STS-1 and concatenated STS-3c, STS-6c, STS-9c, 
STS-12c, STS-24c, STS-48c, or STS-192c speeds. This procedure does not 
apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Type the number of OC-N circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically routed circuits only. If you entered more than 1 in the 
Number of Circuits field, uncheck this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

Step 6 Click Next.

Step 7 Define circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the OC-N circuit size. Choices are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, 
STS-24c, STS-48c, or STS-192c.

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.
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• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this check box, CTC 
provides only protected cards as source and destination choices.

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next.

Step 10 Complete the “DLP-A97 Provision an OC-N Circuit Source and Destination” task on page 8-50 for the 
OC-N circuit you are creating.

Step 11 In the Circuit Routing Preferences area (Figure 8-13 on page 8-44), uncheck Route Automatically. 

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. 

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
check the Dual Ring Interconnect check box.

Step 15 Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit manually. 

Step 16 Complete the “DLP-A98 Provision an OC-N Circuit Route” task on page 8-46.

Step 17 Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error 
message and allows you to change the circuit path. If you entered more than 1 in the Number of Circuits 
field, the Circuit Creation dialog box appears after the circuit is created so you can create the remaining 
circuits. Repeat Steps 5 through 17 for each additional circuit.

Step 18 When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you created 
appear in the window.

Step 19 Complete the “NTP-A62 Test OC-N Circuits” procedure on page 8-54.

Stop. You have completed this procedure.
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DLP-A97 Provision an OC-N Circuit Source and Destination

Step 1 From the Node drop-down menu, choose the node where the circuit will originate.

Step 2 From the Slot drop-down menu, choose the slot containing the OC-N card where the circuit originates. 
(If a card’s capacity is fully utilized, it does not appear in the menu.)

Step 3 Depending on the circuit origination card, choose the source port and/or STS from the Port and STS 
menus. The Port menu is only available if the card has multiple ports. STSs do not appear if they are 
already in use by other circuits.

Note The STSs that appear depend on the card, circuit size, and protection scheme. For example, if 
you create an STS-3c circuit on an OC-12 card in a path protection, only four STSs are available. 
If you create an STS-3c circuit on an OC-12 card in a BLSR, two STSs are available because of 
the BLSR protection characteristics.

Step 4 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Source and repeat Steps 1 through 3 to 
define the secondary source.

Step 5 Click Next.

Step 6 From the Node drop-down menu, choose the destination node.

Step 7 From the Slot drop-down menu, choose the slot containing the OC-N card where the circuit will 
terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear in the menu.)

Step 8 Depending on the card selected in Step 2, choose the destination port and/or STS from the Port and STS 
submenus. The Port menu is available only if the card has multiple ports. The STSs that appear depend 
on the card, circuit size, and protection scheme. 

Step 9 If you need to create a secondary destination, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection, click Use Secondary Destination and repeat Steps 6 through 8 
to define the secondary destination. 

Step 10 Click Next.

Step 11 Return to your originating procedure (NTP).

Purpose This task provisions an OC-N circuit source and destination.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A190 Create a Unidirectional OC-N Circuit with Multiple 
Drops

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 on the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS. 

• Number of Circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

Step 6 Click Next.

Step 7 Define circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, or 
STS-192c.

• Bidirectional—Uncheck this check box for this circuit.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Purpose This procedure creates a unidirectional OC-N circuit with multiple traffic 
drops (circuit destinations). This procedure does not apply to DWDM-only 
nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this check box, CTC 
provides only protected cards as source and destination choices.

Step 8 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A97 Provision an OC-N Circuit Source and Destination” task on page 8-50 for the 
circuit you are creating.

Step 11 Uncheck Route Automatically. When Route Automatically is not selected, the Using Required 
Nodes/Spans and Review Route Before Circuit Creation check boxes are unavailable. 

Step 12 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 13. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes in the Warning dialog box, then continue with Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 13 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection, choose 
one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.
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• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Note For manually routed circuits, CTC checks your manually provisioned path against the path 
diversity option you choose. If the path does not meet the path diversity requirement that is 
specified, CTC displays an error message.

Step 14 If you selected Fully Protected Path in Step 12 and the circuit will be routed on a path protection DRI, 
check the Dual Ring Interconnect check box.

Step 15 Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit manually. 
The green arrows pointing from the selected node to other network nodes indicate spans that are 
available for routing the circuit. 

Step 16 Complete the “DLP-A98 Provision an OC-N Circuit Route” task on page 8-46.

Step 17 Click Finish. After completing the circuit, the Circuits window appears.

Step 18 In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 19 Click Edit. The Edit Circuit window appears with the General tab selected. All nodes in the DCC 
network appear on the network map. Circuit source and destination information appears under the source 
and destination nodes. To see a detailed view of the circuit, click Show Detailed Map. You can rearrange 
the node icons by pressing Ctrl while you drag and drop the icon to the new location.

Step 20 In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 21 Click Create.

Step 22 In the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS—Choose the port and/or STS from the Port and STS drop-down menus. The choice in 
these menus depends on the card selected in Step b. See Table 8-2 on page 8-3 for a list of options.

d. The routing preferences for the new drop match those of the original circuit. However, if the 
following options are available, you can modify them: 

• If the original circuit was routed on a protected path protection path, you can change the nodal 
diversity options: Nodal Diversity Required, Nodal Diversity Desired, or Link Diversity Only. 
See Step 13 for option descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access option 
is available. See Step 12 for a description of the PCA option.

e. If you want to change the circuit state, choose the circuit state from the Target Circuit State 
drop-down menu. The state chosen applies to the entire circuit. 

f. Check Apply to drop ports if you want to apply the state chosen in the Target Circuit State to the 
circuit source and destination drops.

g. Click Finish. The new drop appears in the Drops list.

Step 23 If you need to create additional drops on the circuit, repeat Steps 20 through 22.

Step 24 Click Close. The Circuits window appears.

Step 25 Verify that the new drops appear in the Destination column for the circuit you edited. If they do not 
appear, repeat Steps 21 through 24, making sure all options are provisioned correctly.
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Step 26 Complete the “NTP-A62 Test OC-N Circuits” procedure on page 8-54.

Stop. You have completed this procedure.

NTP-A62 Test OC-N Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab. 

Step 4 Set the circuit and circuit ports to OOS_MT:

a. Click the circuit you want to test.

b. From the Tools menu, choose Circuits > Set Circuit State. 

c. In the Set Circuit State dialog box, choose OOS-MT from the Target Circuit State drop-down menu.

d. If unchecked, check the Apply to drop ports check box.

e. Click Apply.

Step 5 Set up the patch cable at the destination node: 

a. Test the patch cable by connecting one end to the test set transmit (Tx) port and the other end to the 
test receive (Rx) port. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly.

b. Install the loopback cable on the port you are testing. Connect the Tx connector to the Rx connector 
of the port being tested.

Step 6 Set up the loopback cable at the source node:

a. Test the loopback cable by connecting one end to the test set Tx port and the other end to the test Rx 
port. If the test set does not run error-free, check the cable for damage and check the test set to make 
sure it is set up correctly.

b. At the source node, attach the loopback cable to the port you are testing. Connect the test set to the 
circuit source port. Connect the Tx port of the test set to the circuit Rx port, and the test set Rx port 
to the circuit Tx port. 

Purpose This procedure tests an OC-N circuit. This procedure does not apply to 
DWDM-only nodes.

Tools/Equipment Test set capable of OC-N speeds, appropriate fibers, and attenuators

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX and one of following circuit procedures:

NTP-A188 Create an Automatically Routed OC-N Circuit, page 8-42

NTP-A189 Create a Manually Routed OC-N Circuit, page 8-47

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 Configure the test set for the source ONS 15454 card:

• OC-3 cards—You will test either an OC-3c or a multiplexed OC-3. If you are testing an OC-3c, 
configure the test set for an OC-3c. If you are testing a multiplexed OC-3, configure the test set for 
a multiplexed OC-3 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

• OC-12 cards—You will test either an OC-12c or a multiplexed OC-12. If you are testing an OC-12c, 
configure the test set for an OC-12c. If you are testing a multiplexed OC-12, configure the test set 
for a multiplexed OC-12 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

• OC-48 cards—You will test either an OC-48c or a multiplexed OC-48. If you are testing an OC-48c 
configure the test set for an OC-48c. If you are testing a multiplexed OC-48, configure the test set 
for a multiplexed OC-48 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

• OC-192 cards—You will test an OC-192c or a multiplexed OC-192. If you are testing an OC-192c 
configure the test set for an OC-192c. If you are testing a multiplexed OC-192, configure the test set 
for a multiplexed OC-192 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

Step 8 Verify that the test set shows a clean signal. If a clean signal does not appear, repeat Steps 2 through 7 
to make sure you have configured the test set and cabling correctly. 

Step 9 Inject errors from the test set. Verify that the errors appear at the source and destination nodes. 

Step 10 Clear the PM counts for the ports that you tested. See the “DLP-A349 Clear Selected PM Counts” task 
on page 10-8 for instructions.

Step 11 Perform protection switch testing appropriate to the SONET topology:

• For path protection configurations, see the “DLP-A94 Path Protection Switching Test” task on 
page 6-40.

• For BLSRs see the “DLP-A91 BLSR Switch Test” task on page 6-26.

Step 12 Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time. For 
information about configuring your test set for the BERT, see your test set user guide.

Step 13 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results, see your test set user guide. 

Step 14 Change the circuit and circuit ports from OOS_MT to their previous service states:

a. Click the circuit you want to test, then from the Tools menu choose Circuits > Set Circuit State. 

b. In the Set Circuit State dialog box, choose IS (in service), OOS (out of service), or OOS-AINS (auto 
inservice) from the Target Circuit State drop-down menu.

c. If unchecked, check the Apply to drop ports check box.

d. Click Apply.

Stop. You have completed this procedure.
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NTP-A139 Create a Half Circuit on a BLSR or 1+1 Node

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node on the network where you will 
create the half circuit. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—For DS-1 circuits, choose VT. VT cross-connects will carry the DS-1 circuit across 
the ONS 15454 network. For DS-3 or OC-N circuits, choose STS. STS cross-connects will carry the 
DS-3 circuit across the ONS 15454 network. 

• Number of Circuits—Type the number of circuits you want to create. The default is 1.

• Auto-ranged—Uncheck this check box; it is automatically selected if you enter more than 1 in the 
Number of Circuits field.

Step 6 Click Next.

Step 7 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—For DS-3 or OC-N circuits, choose STS-1. For DS-1 circuits, VT1.5 is the default. You cannot 
change it.

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

Purpose This procedure creates a DS-1, DS-3, or OC-N circuit from a drop card to 
an OC-N trunk card on the same node in a BLSR or 1+1 topology. 

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Uncheck this box.

Step 8 Click Next. 

Step 9 Complete the “DLP-A311 Provision a Half Circuit Source and Destination—BLSR and 1+1” task on 
page 8-58.

Step 10 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of Circuits. If auto-ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable at the source or 
destination, a dialog box appears. Set the new source or destination for the remaining circuits, then 
click Finish to continue auto-ranging. After completing the circuit(s), the Circuits window appears.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat Steps 5 
through 10 for each additional circuit. After completing the circuit(s), the Circuits window appears.

Step 11 In the Circuits window, verify that the new circuits appear in the circuits list.

Step 12 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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DLP-A311 Provision a Half Circuit Source and Destination—BLSR and 1+1

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu, choose the node that will contain the half circuit.

Step 2 From the Slot drop-down menu, choose the slot containing the card where the circuit will originate.

Step 3 From the Port drop-down menu, choose the port where the circuit will originate. This field is not 
available if a DS-1 card is chosen in Step 2.

Step 4 If the circuit is a DS-1 circuit and you choose a DS-1 card as the source, choose the DS-1 where the 
traffic will originate from the DS1 drop-down menu. 

Step 5 Click Next. 

Step 6 From the Node drop-down menu, choose the node chosen in Step 1.

Step 7 From the Slot drop-down menu, choose the OC-N card to map the DS-1 to a VT1.5 for OC-N transport 
or to map the DS-3 or OC-N STS circuit to an STS. 

Step 8 Choose the destination STS or VT from the submenus that appear.

Step 9 Return to your originating procedure (NTP).

NTP-A140 Create a Half Circuit on a Path Protection Node

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Purpose This task provisions a half circuit source and destination for BLSR and 1+1 
configurations. This task does not apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a DS1, DS3, or OC-N circuit from a drop to an 
OC-N line card on the same path protection node. This procedure does not 
apply to DWDM-only nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—For DS1 circuits, choose VT. VT cross-connects will carry the DS-1 circuit across 
the ONS 15454 network. For DS-3 or OC-N circuits, choose STS. STS cross-connects will carry the 
DS-3 circuit across the ONS 15454 network. 

• Number of Circuits—Type the number of circuits you want to create. The default is 1.

• Auto-ranged—Uncheck this check box; it is automatically selected if you enter more than 1 in the 
Number of Circuits field.

Step 6 Click Next.

Step 7 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—For DS-1 circuits, VT1.5 is the default. You cannot change it. For DS-3 or OC-N circuits, 
choose STS-1. 

• Bidirectional—Leave checked for this circuit (default).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC applies the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows the ports 
where the circuit state could not be applied. If the box is unchecked, CTC does not change the state 
of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 
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• Protected Drops—Leave this box unchecked.

Step 8 Set the path protection path selectors. See the “DLP-A218 Provision Path Protection Selectors During 
Circuit Creation” task on page 8-11.

Step 9 Click Next. 

Step 10 Complete the “DLP-A312 Provision a Half Circuit Source and Destination—Path Protection” task on 
page 8-60.

Step 11 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of Circuits. If auto-ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable at the source or 
destination, a dialog box appears. Set the new source or destination for the remaining circuits, then 
click Finish to continue auto-ranging. After completing the circuit(s), the Circuits window appears.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat Steps 5 
through 11 for each additional circuit. After completing the circuit(s), the Circuits window appears.

Step 12 In the Circuits window, verify that the new circuits appear in the circuits list.

Step 13 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 8-40. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-A312 Provision a Half Circuit Source and Destination—Path Protection

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node drop-down menu, choose the node that will contain the half circuit.

Step 2 From the Slot drop-down menu, choose the slot containing the card where the circuit will originate.

Step 3 From the Port drop-down menu, choose the port where the circuit will originate. This field is not 
available if a DS-1 card is chosen in Step 2.

Step 4 If the circuit is a DS-1 circuit and you choose a DS-1 card as the source, choose the DS-1 where the 
traffic will originate from the DS1 drop-down menu. 

Purpose This task provisions a half circuit source and destination for a path 
protection. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Circuit Source panel must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Next. 

Step 6 From the Node drop-down menu, choose the node selected in Step 1.

Step 7 From the Slot drop-down menu, choose the OC-N card to map the DS-1 to a VT1.5 for OC-N transport 
or to map the DS-3 or OC-N STS circuit to an STS. 

Step 8 Choose the destination STS or VT from the drop-down menus that appear.

Step 9 Click Use Secondary Destination and repeat Steps 1 through 8.

Step 10 Return to your originating procedure (NTP).

NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode)

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the 
EtherSwitch circuit. If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 8-64 to verify that sufficient VLAN capacity is available. (You will 
create a VLAN during each circuit creation task.)

Step 3 If enough VLANs are not available, complete the “DLP-A335 Delete VLANS” task on page 8-65 to free 
space.

Step 4 Verify that the circuit source and destination Ethernet cards are provisioned for the mode of the circuit 
you will create, either multicard or single-card. See the “DLP-A246 Provision E-Series Ethernet Card 
Mode” task on page 8-65.

Step 5 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 8-66.

Step 6 From the View menu, choose Go to Network View. 

Step 7 Click the Circuits tab, then click Create.

Step 8 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable.

Purpose This procedure creates a multicard or single-card EtherSwitch circuit. It 
does not apply to E-Series cards in port-mapped mode. To create a 
port-mapped mode circuit, see NTP-A192 Create a Circuit for an E-Series 
Card in Port-Mapped Mode, page 8-68. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at each end of the Ethernet circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 Click Next.

Step 10 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. Valid circuit sizes for an Ethernet multicard circuit are STS-1, 
STS-3c, and STS6c. Valid circuit sizes for an Ethernet single-card circuit are STS-1, STS-3c, 
STS6c, and STS12c.

• Bidirectional—Leave the default unchanged (checked).

• State—Choose IS (in service). Ethergroup circuits are stateless and always in service.

• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series Ethernet card ports.

• Create cross-connects only (TL1-like)—Uncheck this box; it does not apply to Ethernet circuits. 

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 11 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Caution Layer 1 SONET protection does not extend to multicard EtherSwitch circuits on path protection. 

Caution A TCC2 card reset disrupts single-card and multicard Etherswitch circuits for 45 seconds to two minutes. 
During this time a spanning tree topology is created by the newly activated TCC2 card.

Step 12 Click Next.

Step 13 Provision the circuit source:

a. From the Node drop-down menu, choose one of the EtherSwitch circuit endpoint nodes. (Either end 
node can be the EtherSwitch circuit source.)

b. From the Slot drop-down menu, choose one of the following:

• If you are building a multicard EtherSwitch circuit, choose Ethergroup.

• If you are building a single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 14 Click Next.

Step 15 Provision the circuit destination:

a. From the Node drop-down menu, choose the second EtherSwitch circuit endpoint node.

b. From the Slot drop-down menu, choose one of the following:

• If you are building a multicard EtherSwitch circuit, choose Ethergroup.

• If you are building a single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 16 Click Next.

Step 17 In the Circuit VLAN Selection area, click New VLAN. If the desired VLAN already exists, continue 
with Step 20.
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Tip You can also add VLANs in network view by choosing Tools > Manage VLANs. In the All 
VLANs dialog box, click the Create button to open the Define New VLAN dialog box.

Step 18 In the Define New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 and 
4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports a 
maximum of 509 user-provisionable VLANs.

• Topology ID—Choose the topology ID from the drop-down menu. 

Step 19 Click OK.

Step 20 In the Circuit VLAN Selection area, highlight the VLAN name and click the arrow button (>>) to move 
the available VLAN(s) to the Circuit VLANs column. 

Step 21 If you are building a single-card EtherSwitch circuit and want to disable spanning tree protection on this 
circuit, uncheck the Enable Spanning Tree check box and click OK in the Disabling Spanning Tree 
dialog box. The Enable Spanning Tree box remains checked or unchecked for the creation of the next 
single-card, point-to-point Ethernet circuit.

Caution Disabling spanning-tree protection increases the likelihood of logic loops on an Ethernet network.

Caution Turning off spanning tree on a circuit-by-circuit basis means that the ONS 15454 is no longer protecting 
the Ethernet circuit and that the circuit must be protected by another mechanism in the Ethernet network.

Caution Multiple circuits with spanning tree protection enabled incur blocking if the circuits traverse the same 
E-Series card and use the same VLAN. 

Note Spanning-tree rules prevent users from creating new circuits or modifying existing circuits if the circuits 
do not meet certain VLAN assignment constraints. If the VLAN set of the new circuit overlaps existing 
circuits, the same spanning-tree instance is used for all circuits. If the VLAN set of the new circuit 
overlaps with VLAN sets of existing circuits with different spanning-tree instances, the VLAN 
assignment fails. Cisco recommends that you plan VLAN assignments so that circuits with larger VLAN 
sets and a higher chance of overlap are added first. This means that if a circuit with an overlapping 
VLAN set is added, it collapses into the same spanning tree. To view circuits mapped to a spanning tree 
and their VLAN assignments, see the “DLP-A430 View Spanning Tree Information” task on page 11-11.

Note You can disable or enable spanning tree protection on a circuit-by-circuit basis only for single-card, 
point-to-point Ethernet circuits. Other E-Series Ethernet configurations disable or enable spanning tree 
on a port-by-port basis.

Step 22 Click Next.

Step 23 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:
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• Circuit name

• Circuit type

• Circuit size

• ONS 15454 nodes

Step 24 If the information is not correct, click the Back button and repeat Steps 8 through 23 with the correct 
information. If the information is correct, check Route Automatically.

Step 25 Click Finish.

Step 26 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67.

Stop. You have completed this procedure.

DLP-A99 Determine Available VLANs

Step 1 In any CTC view, click the Circuits tab.

Step 2 Click any existing Ethernet circuit.

Step 3 Click Edit, then click the VLANs tab.

The Edit Circuit dialog shows the number of VLANs used by circuits and the total number of VLANs 
available for use. 

Step 4 Determine that number of available VLANs listed is sufficient for the number of E-Series Ethernet 
circuits that you will create.

Caution Multiple E-Series Ethernet circuits with spanning tree enabled block each other if the circuits traverse 
the same E-Series Ethernet card and use the same VLAN.

Step 5 Return to the originating procedure (NTP). 

Purpose This task verifies that the network has the capacity to support the additional 
new VLANs required for the creation E-Series circuits. It does not apply 
to E-Series cards in port-mapped mode. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at each end of the Ethernet circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A335 Delete VLANS

Step 1 From the View menu, choose Go to Network View.

Step 2 From the Tools menu, choose Manage VLANS. 

Step 3 In the All VLANs dialog box, click the VLAN that you want to remove.

Step 4 Click Delete. 

Step 5 In the confirmation dialog box, click Yes.

Step 6 Return to your originating procedure (NTP).

DLP-A246 Provision E-Series Ethernet Card Mode

Caution You cannot change the mode while the Ethernet card is carrying circuits. If you want change the card 
mode, delete any circuits that it carries first. See the “NTP-A278 Modify and Delete Overhead Circuits” 
procedure on page 11-19.

Step 1 In the network view, double-click the node containing the E-Series Ethernet card you want to provision, 
then double-click the Ethernet card.

Step 2 Click the Provisioning > Ether Card tabs.

Step 3 In the Card Mode area, choose one of the following: 

• For multicard EtherSwitch circuit groups, choose Multicard EtherSwitch Group. 

• For single-card EtherSwitch circuits, choose Single-card EtherSwitch. 

• For port-mapped circuits, choose Port-mapped. 

Purpose This task removes VLANs from a domain. 

Tools/Equipment None

Prerequisite Procedures See Chapter 8, “Create Circuits and VT Tunnels” for circuit creation 
procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions an E-Series Ethernet card for multicard EtherSwitch 
Group, single-card EtherSwitch, or port-mapped mode. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
8-65
Cisco ONS 15454 Procedure Guide, R4.6

December 2004



 

Chapter 8      Create Circuits and VT Tunnels
DLP-A220 Provision E-Series Ethernet Ports
Step 4 Click Apply.

Step 5 If you are using multicard EtherSwitch circuits, repeat Steps 2 through 4 for all other Ethernet cards in 
the node that will carry the multicard EtherSwitch circuits.

Step 6 Repeat Steps 1 through 5 for other nodes as necessary. 

Step 7 Return to your originating procedure (NTP).

DLP-A220 Provision E-Series Ethernet Ports

Step 1 In node view, double-click the Ethernet card that you want to provision.

Step 2 Click the Provisioning > Ether Port tabs.

Step 3 For each Ethernet port, provision the following parameters:

• Port Name—If you want to label the port, type a port name.

• Mode—Choose the appropriate mode for the Ethernet port:

– Valid choices for the E100T-12/E100T-G card are Auto, 10 Half, 10 Full, 100 Half, or 100 Full. 

– Valid choices for the E1000-2/E1000-2-G card are 1000 Full or Auto.

Note Both 1000 Full and Auto mode set the E1000-2 port to the 1000 Mbps and Full duplex 
operating mode; however, flow control is disabled when 1000 Full is selected. Choosing 
Auto mode enables the E1000-2 card to autonegotiate flow control. Flow control is a 
mechanism that prevents network congestion by ensuring that transmitting devices do not 
overwhelm receiving devices with data. The E1000-2 port handshakes with the connected 
network device to determine if that device supports flow control.

• Enabled—Check this check box to activate the corresponding Ethernet port.

• Priority—Choose a queuing priority for the port. Options range from 0 (Low) to 7 (High). Priority 
queuing (IEEE 802.1Q) reduces the impact of network congestion by mapping Ethernet traffic to 
different priority levels. Refer to the priority queuing information in the Cisco ONS 15454 Reference 
Manual. This parameter does not apply to an E-Series card in port-mapped mode.

• Stp Enabled—Check this check box to enable the Spanning Tree Protocol (STP) on the port. This 
parameter does not apply to an E-Series card in port-mapped mode. Refer to the spanning tree 
information in the Cisco ONS 15454 Reference Manual.

Step 4 Click Apply.

Purpose This task enables the E100T-12, E100T-G, E1000-2, and E1000-2-G ports 
to carry traffic. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Provisioning or higher
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Step 5 Repeat Steps 1 through 4 for all other cards in the VLAN, or if the E-Series card is in port-mapped mode, 
repeat Steps 1 through 4 for the other card in a point-to-point circuit.

Step 6 Your Ethernet ports are provisioned and ready to be configured for VLAN membership. See the 
“DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67 for 
instructions.

Step 7 Return to your originating procedure (NTP).

DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership

Step 1 In node view, double-click the E-Series card graphic to open the card.

Step 2 Click the Provisioning > Ether VLAN tabs.

Step 3 To put a port in a VLAN:

a. Click the port and choose either Tagged or Untag. 

b. If a port is a member of only one VLAN, choose Untag from the Port column in the VLAN’s row. 
Choose -- for all the other VLAN rows in that Port column. 

Note The VLAN with Untag selected can connect to the port, but other VLANs cannot access that 
port.

c. Choose Tagged at all VLAN rows that need to be trunked. Choose Untag at VLAN rows that do not 
need to be trunked, for example, the default VLAN. 

Note Each Ethernet port must be attached to at least one untagged VLAN. A trunk port connects 
multiple VLANs to an external device, such as a switch, which also supports trunking. A 
trunk port must have tagging (IEEE 802.1Q) enabled for all the VLANs that connect to that 
external device. 

Step 4 After each port is in the appropriate VLAN, click Apply. Table 8-4 lists VLAN settings.

. 

Purpose This task provisions E-Series card ports for VLAN membership. It does not 
apply to E-Series cards in port-mapped mode. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 8-4 VLAN Settings

Setting Description

-- A port marked with this symbol does not belong to the VLAN.
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Note If Tagged is chosen, the attached external Ethernet devices must recognize IEEE 802.1Q 
VLANs.

Note Both ports on an E1000-2/E1000-2-G card cannot be members of the same VLAN.

Step 5 Return to your originating procedure (NTP).

NTP-A192 Create a Circuit for an E-Series Card in Port-Mapped 
Mode

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 4.

Step 2 Provision the Ethernet cards that will carry the circuit for port-mapped mode. See the “DLP-A246 
Provision E-Series Ethernet Card Mode” task on page 8-65.

Step 3 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 8-66.

Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab and click Create.

Step 6 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 7 Click Next.

Untag The ONS 15454 tags ingress frames and strips tags from egress frames.

Tagged The ONS 15454 processes ingress frames according to the VLAN ID; egress 
frames do not have their tags removed.

Table 8-4 VLAN Settings (continued)

Setting Description

Purpose This procedure creates an E-Series point-to-point SONET circuit with an 
E-Series card in port-mapped mode. 

Tools/Equipment An E-Series Ethernet card must be installed at each end of the circuit and 
configured in port-mapped mode.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. Valid circuit sizes for an E-Series circuit are STS-1, STS-3c, STS6c, 
and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Check this check box if you want to apply the state chosen in the State field 
(IS or OOS-MT only) to the Ethernet circuit source and destination ports. You cannot apply 
OOS-AINS to E-Series Ethernet card ports. CTC applies the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog box shows 
the ports where the circuit state could not be applied. If the box is unchecked, CTC does not change 
the state of the source and destination ports.

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 9 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 10 Click Next.

Step 11 Provision the circuit source:

a. From the Node drop-down menu, choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot drop-down menu, choose the slot containing the E-Series card that you will use for 
one end of the point-to-point circuit.

c. From the Port drop-down menu, choose a port.

Step 12 Click Next.
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Step 13 Provision the circuit destination:

a. From the Node drop-down menu, choose the circuit destination node.

b. From the Slot drop-down menu, choose the slot containing the E-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port drop-down menu, choose a port.

Step 14 Click Next. 

Step 15 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15454 nodes

Step 16 If the information is not correct, click the Back button and repeat Steps 6 through 15 with the correct 
information. If the information is correct, check Route Automatically.

Step 17 Click Finish.

Step 18 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 8-81.

Stop. You have completed this procedure.

NTP-A142 Create an E-Series Shared Packet Ring Ethernet 
Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 8-64 to verify that sufficient VLAN capacity is available. (You will 
create a VLAN during each circuit creation task.)

Step 3 Verify that the Ethernet cards that will carry the circuit are provisioned for the Multicard EtherSwitch 
Group. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 8-65.

Step 4 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 8-66.

Purpose This procedure creates a shared packet ring Ethernet circuit. It does not 
apply to E-Series cards in port-mapped mode. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at both Ethernet circuit endpoint nodes.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 From the View menu, choose Go to Network View. 

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 8 Click Next.

Step 9 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. Valid shared packet ring circuit sizes are STS-1, STS-3c, and STS6c.

• Bidirectional—Leave the default unchanged (checked).

• State—The circuit is in service (default).

• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series ports.

• Create cross-connects only (TL1-like)—Uncheck this box; it does not apply to Ethernet circuits. 

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 10 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Caution Layer 1 SONET protection does not extend to multicard EtherSwitch circuits on path protection. 

Step 11 Click Next.

Step 12 Provision the circuit source:

a. From the Node drop-down menu, choose one of the shared packet ring circuit endpoint nodes. 
(Either end node can be the shared packet ring circuit source.)

b. From the Slot drop-down menu, choose Ethergroup.

Step 13 Click Next.

Step 14 Provision the circuit destination:

a. From the Node drop-down menu, choose the second shared packet ring circuit endpoint node.

b. From the Slot drop-down menu, choose Ethergroup.

Step 15 Click Next.

Step 16 Review the VLANs listed in the Available VLANs list. If the VLAN you want to use appears, continue 
with Step 17. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. In the Define New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily identifiable name to your VLAN.
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• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

• Topology ID—Choose the topology ID from the drop-down menu.

c. Click OK.

Tip You can also add VLANs in network view by choosing Tools > Manage VLANs. In the All 
VLANs dialog box, click the Create button to open the Define New VLAN dialog box.

Step 17 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 18 Click Next.

Step 19 In the Circuit Routing Preferences area, uncheck the Route Automatically check box and click Next.

Step 20 In the Route Review and Edit area, click the source node, then click a span (green arrow) leading away 
from the source node. 

The span turns white.

Step 21 Click Add Span.

The span turns blue. CTC adds the span to the Included Spans list.

Step 22 Click the node at the end of the blue span.

Step 23 Click the green span joining the node selected in Step 22. 

The span turns white.

Step 24 Click Add Span.

The span turns blue.

Step 25 Repeat Steps 21 through 24 for every node in the ring. 

Step 26 In the Route Review and Edit area, verify that the new circuit is correctly configured. If the circuit 
information is not correct, click the Back button and repeat Steps 7 through 25 with the correct 
information. 

Note If the circuit is incorrect, you can also click Finish, delete the completed circuit, and begin the 
procedure again.

Step 27 Click Finish.

Step 28 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 8-66 for each node that 
carries the circuit.

Step 29 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67 
for each node that carries the circuit.

Step 30 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 8-81.
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Stop. You have completed this procedure.

NTP-A143 Create an E-Series Hub-and-Spoke Ethernet 
Configuration

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the hub node (the common endpoint). If 
you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-A99 Determine Available VLANs” task on page 8-64 to verify that sufficient VLAN 
capacity is available. (You will create a VLAN during each circuit creation task.)

Step 3 Display the node view. 

Step 4 Verify that the Ethernet card that will carry the hub-and-spoke circuit is provisioned for Single-card 
EtherSwitch Group. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 8-65.

Step 5 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 8-66.

Step 6 Log into a spoke endpoint node and repeat Steps 3 through 5 for the destination Ethernet card. You only 
need to verify that the hub node is provisioned for single-card EtherSwitch once.

Step 7 Click the Circuits tab and click Create.

Step 8 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 9 Click Next.

Step 10 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size.

• Bidirectional—Leave the default unchanged (checked).

• State—The circuit is in service (default).

Purpose This procedure creates a hub-and-spoke Ethernet configuration, which is 
made up of multiple circuits that share a common endpoint. It does not 
apply to E-Series cards in port-mapped mode. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at all Ethernet circuit endpoint nodes.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series ports. 

• Create cross-connects only (TL1-like)—Uncheck this box; it does not apply to Ethernet circuits.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 11 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 12 Click Next.

Step 13 Provision the circuit source:

a. From the Node drop-down menu, choose the hub node.

b. From the Slot drop-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 14 Click Next.

Step 15 Provision the circuit destination:

a. From the Node drop-down menu, choose an EtherSwitch circuit endpoint node.

b. From the Slot drop-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 16 Click Next.

Step 17 Review the VLANs listed in the Available VLANs list. If the VLAN you want to use appears, continue 
with Step 19. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. In the Define New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

• Topology ID—Choose the topology ID from the drop-down menu.

c. Click OK.

Tip You can also add VLANs in network view by choosing Tools > Manage VLANs. In the All 
VLANs dialog box, click the Create button to open the Define New VLAN dialog box.

Step 18 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 19 Click Next.

Step 20 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:

• Circuit name
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• Circuit type

• Circuit size

• VLAN names

• ONS 15454 nodes

Step 21 If the information is not correct, click the Back button and repeat Steps 8 through 20 with the correct 
information. If the information is correct, check Route Automatically.

Step 22 Click Finish. 

Step 23 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 8-66. 

Step 24 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67.

Step 25 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 8-81.

Step 26 To create additional circuits (spokes), repeat Steps 2 through 25.

Stop. You have completed this procedure.

NTP-A144 Create an E-Series Single-Card EtherSwitch Manual 
Cross-Connect

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 8-64 to verify that sufficient VLAN capacity is available. (You will 
create a VLAN during each circuit creation task.)

Step 4 In the node view, double-click the Ethernet card that will carry the cross-connect.

Purpose This procedure manually creates a single-card EtherSwitch cross-connect 
between E-Series Ethernet cards and OC-N cards connected to non-ONS 
equipment. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Verify that the Ethernet cards that will carry the circuit are provisioned for single-card EtherSwitch. See 
the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 8-65.

Step 6 From the View menu, choose Go to Network View.

Step 7 Click the Circuits tab and click Create.

Step 8 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

Step 9 Click Next.

Step 10 Define the circuit attributes:

• Name—Assign a name to the cross-connect. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the cross-connect.

• Size—Choose the cross-connect size. For single-card EtherSwitch, the available sizes are STS-1, 
STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• State—The circuit is in service (default).

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 11 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 12 Click Next.

Step 13 Provision the circuit source:

a. From the Node drop-down menu, choose the cross-connect source node. 

b. From the Slot drop-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch in Step 5.

Step 14 Click Next.

Step 15 Provision the circuit destination:

a. From the Node drop-down menu, choose the cross-connect circuit source node selected in Step 13. 
(For Ethernet cross-connects, the source and destination nodes are the same.)

b. From the Slot drop-down menu, choose the OC-N card that is connected to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and/or STS from the Port and STS drop-down menus.

Step 16 Click Next.

Step 17 Review the VLANs listed in the Available VLANs list. If the VLAN you want to use appears, continue 
with Step 18. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. In the Define New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily identifiable name to your VLAN.
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• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

• Topology ID—Choose the topology ID from the drop-down menu.

c. Click OK.

Tip You can also add VLANs in network view by choosing Tools > Manage VLANs. In the All 
VLANs dialog box, click the Create button to open the Define New VLAN dialog box.

Step 18 Click the VLAN you want to use on the Available VLANs column, then click the arrow >> button to 
move the VLAN to the Circuit VLANs column. 

Step 19 Click Next. 

Step 20 In the left pane of the Circuit Routing Preferences panel, confirm that the following information about 
the single-card EtherSwitch manual cross-connect is correct (in this task, “circuit” refers to the Ethernet 
cross-connect):

• Circuit name

• Circuit type

• Circuit size

• VLAN names

• ONS 15454 nodes

Step 21 If the information is not correct, click the Back button and repeat Steps 8 through 20 with the correct 
information. If the information is correct, check Route Automatically.

Step 22 Click Finish.

Step 23 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 8-66. 

Step 24 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67.

Stop. You have completed this procedure.

NTP-A145 Create an E-Series Multicard EtherSwitch Manual 
Cross-Connect

Purpose This procedure manually creates multicard EtherSwitch cross-connects 
between E-Series Ethernet cards and an OC-N cards connected to 
non-ONS equipment. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-A99 Determine Available VLANs” task on page 8-64 to verify that sufficient VLAN 
capacity is available. (You will create a VLAN during each circuit creation task.)

Step 3 Verify that the Ethernet card that will carry the circuit is provisioned for Multicard EtherSwitch Group. 
See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 8-65.

Step 4 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 8-66.

Step 5 From the View menu, choose Go to Network View.

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 8 Click Next.

Step 9 Define the circuit attributes:

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 
48 characters (including spaces). Circuit names should be 44 characters or less if you want the 
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to the 
source cross-connect.

• Size—Choose the size of the circuit that will be carried by the cross-connect. For multicard 
EtherSwitch circuits, the available sizes are STS-1, STS-3c, and STS-6c.

• Bidirectional—Leave checked (default).

• State—The circuit is in service (default).

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 10 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 11 Click Next.

Step 12 Provision the cross-connect source:

a. From the Node drop-down menu, choose the cross-connect source node.

b. From the Slot drop-down menu, choose Ethergroup.
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Step 13 Click Next.

Step 14 From the Node drop-down menu in the Destination area, choose the circuit source node selected in 
Step 12. For Ethernet cross-connects, the source and destination nodes are the same.

The Slot field is provisioned automatically for Ethergroup.

Step 15 Click Next.

Step 16 Review the VLANs listed in the Available VLANs list. If the VLAN you want to use appears, continue 
with Step 18. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. In the Define New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

• Topology ID—Choose the topology ID from the drop-down menu.

c. Click OK.

Tip You can also add VLANs in network view by choosing Tools > Manage VLANs. In the All 
VLANs dialog box, click the Create button to open the Define New VLAN dialog box.

Step 17 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Step 18 Click Next.

Step 19 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:

• Circuit name

• Circuit type

• Circuit size

• VLANs

• ONS 15454 nodes

Step 20 If the information is not correct, click the Back button and repeat Steps 7 through 19 with the correct 
information. If the information is correct, check Route Automatically.

Step 21 Click Finish.

Step 22 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 8-66. 

Step 23 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 8-67.

Step 24 From the View menu, choose Go to Home View.

Step 25 Click the Circuits tab.

Step 26 Highlight the circuit and click Edit.

The Edit Circuit dialog box appears.

Step 27 In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.

Step 28 Click Create.
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Step 29 In the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the OC-N card that links the ONS 15454 to the non-ONS 15454 equipment.

c. Port, STS—Choose the port and/or STS from the Port and STS drop-down menus. 

d. The routing preferences for the new drop match those of the original circuit. However, if the 
following options are available, you can modify them: 

• If the original circuit was routed on a protected path protection path, you can change the nodal 
diversity options: Nodal Diversity Required, Nodal Diversity Desired, or Link Diversity Only. 

• If the original circuit was not routed on a protected path, the Protection Channel Access option 
is available. 

e. If you want to change the circuit state, choose the circuit state from the Target Circuit State 
drop-down menu. The state chosen applies to the entire circuit. 

f. Check Apply to drop ports if you want to apply the state chosen in the Target Circuit State to the 
circuit source and destination drops.

g. Click Finish. The new drop appears in the Drops list.

Step 30 Confirm the circuit information that appears in the Edit Circuit dialog box and click Close.

Step 31 Repeat Steps 2 through 30 at the second Ethernet manual cross-connect endpoint. 

The first and second Ethernet manual cross-connect endpoints will be bridged by the OC-N STS 
cross-connect circuit.

Note The appropriate STS circuit must exist in the non-ONS equipment to connect the two Ethernet 
manual cross-connect endpoints.

Caution If a CARLOSS alarm repeatedly appears and clears on an Ethernet manual cross-connect, the two 
Ethernet circuits might have a circuit-size mismatch. For example, a circuit size of STS-3c was 
configured on the first ONS 15454 and circuit size of STS-12c was configured on the second 
ONS 15454. Refer to the Cisco ONS 15454 Troubleshooting Guide if the alarm persists.

Step 32 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 8-81.

Stop. You have completed this procedure.
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NTP-A146 Test E-Series Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the ONS 15454 source Ethernet node.

Step 2 On the shelf graphic, double-click the circuit source card. 

Step 3 Click the Provisioning > Ether Port tabs.

Step 4 Verify the following settings:

• Mode—Auto, 10 Half, 10 Full, 100 Half, or 100 Full.

• Enabled—Checked.

• Priority—Set to the priority level indicated by the circuit or site plan. Priority does not apply to 
E-Series cards in port-mapped mode.

• Stp State—Checked if Spanning Tree Protocol is enabled for the circuit. Stp does not apply to 
E-Series cards in port-mapped mode.

Step 5 Click the Ether VLAN tab. If the E-Series cards is not in port-mapped mode, verify that the source port 
is on the same VLAN as the destination port.

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node, connect the Ethernet test set to the destination port and configure the test set to 
send and receive the appropriate Ethernet traffic. 

Note At this point, you are not able to send and receive Ethernet traffic.

Step 8 At the source node, connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 8 to make sure you configured the Ethernet ports and test set 
correctly.

Purpose This procedure tests circuits created on E-Series Ethernet cards 
provisioned for multicard EtherSwitch, single-card EtherSwitch, or 
port-mapped mode. 

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX, and one of the following: 

NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode), page 8-61

NTP-A142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 
8-70

NTP-A143 Create an E-Series Hub-and-Spoke Ethernet Configuration, 
page 8-73

Required/As Needed As needed

Onsite/Remote Onsite

Security Provisioning or higher
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Step 10 Perform protection switch testing appropriate to the SONET topology:

• For path protection configurations, see the “DLP-A94 Path Protection Switching Test” task on 
page 6-40.

• For BLSRs see the “DLP-A91 BLSR Switch Test” task on page 6-26.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 After the Ethernet test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results, see your test set user guide.

Stop. You have completed this procedure.

NTP-A147 Create a G-Series STS Circuit

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields: 

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 5 Click Next.

Step 6 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. Valid circuit sizes for a G-Series circuit are STS-1, STS-3c, STS6c, 
STS-9c, STS-12c, STS-24c, and STS-48c. 

Note Restrictions apply to provisioning multiple circuits on a G-Series card when one of the 
circuit sizes provisioned is STS-24c. Refer to the Cisco ONS 15454 Reference Manual for 
complete information.

• Bidirectional—Leave the default unchanged (checked).

Purpose This procedure creates a G-Series circuit. 

Tools/Equipment A G-Series Ethernet card must be installed at each end of the circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Leave this box at the default (unchecked).

Note Loss of signal alarms appear if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 7 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Note For circuits routed on path protection, check Switch on PDI-P if you desire to override the 
G-Series Ethernet Link Integrity feature. Switch on PDI-P configures the card to switch traffic 
when an STS payload defect indicator (PDI-P) is received. Under Ethernet Link Integrity, the 
PDI-P indication normally triggers a bidirectional failure. Overriding the Ethernet Link Integrity 
feature might be desired for applications utilizing dual Gigabit Ethernet feeds from a customer's 
location or drop and continue paths. 

Step 8 Click Next.

Step 9 Provision the circuit source:

a. From the Node drop-down menu, choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot drop-down menu, choose the slot containing the G-Series card that you will use for 
one end of the point-to-point circuit.

c. From the Port drop-down menu, choose a port.

Step 10 Click Next.

Step 11 Provision the circuit destination:

a. From the Node drop-down menu, choose the circuit destination node.

b. From the Slot drop-down menu, choose the slot containing the G-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port drop-down menu, choose a port.

Step 12 Click Next. 

Step 13 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:
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• Circuit name

• Circuit type

• Circuit size

• ONS 15454 nodes

Step 14 If the information is not correct, click the Back button and repeat Steps 4 through 13 with the correct 
information. If the information is correct, check Route Automatically.

Step 15 Click Finish.

Note To change the capacity of a G-Series circuit, you must delete the original circuit and reprovision 
a new larger circuit.

Step 16 Complete the “NTP-A149 Test G-Series Circuits” procedure on page 8-91.

Stop. You have completed this procedure.

NTP-A148 Create a Manual Cross-Connect for a G-Series or 
E-Series Card in Port-Mapped Mode 

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the 
cross-connect. If you are already logged in, continue with Step 2.

Step 2 If you are provisioning an E-Series card, verify that the Ethernet card that will carry the circuit is 
provisioned for port-mapped mode. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task 
on page 8-65.

Step 3 If you are provisioning a G-Series card, complete the “DLP-A222 Provision G-Series Ethernet Ports” 
task on page 8-86.

Step 4 If you want to change the default flow control settings, complete the “DLP-A421 Provision G-Series 
Flow Control Watermarks” task on page 8-87.

Purpose This procedure creates a manual cross-connect between a G-Series 
Ethernet card or an E-Series Ethernet card in port-mapped mode and an 
OC-N card connected to non-ONS equipment. 

Tools/Equipment A G-Series or E-Series card must be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click the Circuits tab and click Create.

Step 6 In the Create Circuits dialog box, complete the following fields:

• Circuit Type—Choose STS.

• Number of Circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

Step 7 Click Next.

Step 8 Define the circuit attributes:

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 
48 characters (including spaces). Circuit names should be 44 characters or less if you want the 
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to the 
source cross-connect.

• Size—Choose the size of the circuit that will be carried by the cross-connect. Valid sizes for a 
G-Series circuit are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, and STS-48c. For an 
E-Series card in port-mapped mode, valid sizes are STS-1, STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• State—The circuit is in service (default).

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a UCP channel, enter the service level 
agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 9 If the circuit will be routed on a path protection, complete the “DLP-A218 Provision Path Protection 
Selectors During Circuit Creation” task on page 8-11.

Step 10 Click Next.

Step 11 Provision the circuit source:

a. From the Node drop-down menu, choose the circuit source node. 

b. From the Slot drop-down menu, choose the Ethernet card that will be the cross-connect source.

c. From the Port drop-down menu, choose the cross-connect source port.

Step 12 Click Next.

Step 13 Provision the circuit destination:

a. From the Node drop-down menu, choose the cross-connect source node selected in Step 11. (For 
Ethernet cross-connects, the source and destination nodes are the same.)

b. From the Slot drop-down menu, choose the OC-N card that connects to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and STS from the Port and STS drop-down menus.

Step 14 Click Next.

Step 15 In the left pane of the Circuit Routing Preferences panel, confirm that the following information is 
correct:

• Circuit name

• Circuit type

• Circuit size
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• ONS 15454 nodes

Step 16 If the information is not correct, click the Back button and repeat Steps 5 through 15 with the correct 
information. If the information is correct, check Route Automatically.

Step 17 Click Finish.

Stop. You have completed this procedure.

DLP-A222 Provision G-Series Ethernet Ports

Step 1 In the node view, double-click the G-Series card graphic to open the card.

Step 2 Click the Provisioning > Port tabs.

Step 3 For each G-Series port, provision the following parameters:

• Port Name—If you want to label the port, type the port name.

• State—Choose IS to put the port in service.

• Flow Control Neg—Check this check box to enable flow control negotiation on the port (default). 
If you do not want to enable flow control, uncheck the box. 

Note To activate flow control, the Ethernet device attached to the G-Series card must be set to 
autonegotiation. If flow control is enabled but the negotiation status indicates no flow 
control, check the autonegotiation settings on the attached Ethernet device.

• Max Size—To permit the acceptance of jumbo size Ethernet frames, choose Jumbo (default). If you 
do not want to permit jumbo size Ethernet frames, choose 1548.

Note The maximum frame size of 1548 bytes enables the port to accept valid Ethernet frames that use 
protocols, such as ISL. ISL adds 30 bytes of overhead and might cause the frame size to exceed 
the traditional 1518 byte maximum.

Step 4 Click Apply.

Step 5 Refresh the Ethernet statistics:

a. Click the Performance > Statistics tabs.

b. Click Refresh.

Purpose This task provisions G-Series Ethernet ports to carry traffic. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Reprovisioning an Ethernet port on the G-Series card does not reset the Ethernet statistics for 
that port. 

Step 6 Return to your originating procedure (NTP). 

DLP-A421 Provision G-Series Flow Control Watermarks

Step 1 In the node view, double-click the G-Series card graphic to open the card.

Step 2 Click the Provisioning > Port tabs.

Step 3 In the Water Marks column, click the cell in the row for the appropriate port.

Step 4 To provision the Low Latency flow control watermark:

a. Choose Low Latency from the drop-down menu.

The Flow Ctrl Lo and Flow Ctrl Hi values change.

b. Click Apply.

Step 5 To provision a Custom flow control watermark:

a. Choose Custom from the drop-down menu.

b. In the Flow Ctrl Lo column, click the cell in the row for the appropriate port.

c. Enter a value in the cell. The Flow Ctrl Lo value has a valid range from 1 to 510 and must be lower 
than the Flow Ctrl Hi value.

This value sets the flow control threshold for sending the signal to the attached Ethernet device to 
resume transmission. 

d. In the Flow Ctrl Hi column, click the cell in the row for the appropriate port.

e. Enter a value in the cell. The Flow Ctrl Hi value has a valid range from 2 to 511 and must be higher 
than the Flow Ctrl Lo value.

This value sets the flow control threshold for sending the signal to the attached Ethernet device to 
pause transmission. 

f. Click Apply.

Purpose This task provisions the buffer memory levels for flow control on G-Series 
Ethernet ports. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Low watermarks are optimum for low latency subrate applications, such as voice-over-IP (VoIP) 
using an STS-1. High watermarks are optimum when the attached Ethernet device has 
insufficient buffering, best effort traffic, or long access line lengths.

Step 6 Return to your originating procedure (NTP). 

NTP-A241 Provision G-Series Ports for Transponder Mode

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will provision G-Series 
ports. If you are already logged in, continue with Step 2.

Step 2 In the node view, double-click the G-Series card graphic to open the card.

Step 3 Click the Provisioning > Port tabs.

Step 4 To put a pair of G-Series card ports in two-port bidirectional transponder mode (Figure 8-15):

In this step, “Port A” represents the first port in a pair and “Port B” the second port in the pair. You can 
pair any two ports on a G-Series card in two-port bidirectional mode.

a. Click the Port A row (for example, Port 1).

b. In the TXP Mode column, choose TX/RX from the drop-down menu.

c. In the TXP Port column, choose the port number that reflects Port A (for example, Port 1).

d. Click a Port B row (for example, Port 2). 

e. In the TXP Mode column, choose TX/RX from the drop-down menu.

f. In the TXP Port column, choose Port A (for example, Port 1) from the drop-down menu.

g. Click Apply.

The ports in the card view have arrows and a connecting line between the back of the ports.

Purpose This procedure provisions G-Series ports into transponder mode. 

Tools/Equipment None

Prerequisite Procedures A222 Provision G-Series Ethernet Ports, page 86

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 8-15 Two-Port Bidirectional Transponder Mode

Step 5 To put a G-Series card port in one-port bidirectional transponder mode (Figure 8-16):

a. Click the desired port row (for example, Port 1).

b. In the TXP Mode column, choose TX/RX from the drop-down menu.

c. In the TXP Port column, choose the desired port from the drop-down menu (for example, Port 1).

d. Click Apply.

In card view, the desired port has arrows and a curved line on the back of the port.

TXP Mode columnConfirmationTXP Port
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Figure 8-16 One-Port Bidirectional Transponder Mode

Step 6 To provision two-port unidirectional transponder mode (Figure 8-17):

In this step, “Port A” represents the first port in a pair and “Port B” the second port in the pair. You can 
pair any two ports on a G-Series card in two-port unidirectional mode.

a. Click the Port A row (for example, Port 1).

b. Uncheck Flow Control Neg. Ports cannot be provisioned in unidirectional transponder mode when 
autonegotiation is enabled.

c. In the TXP Port column, choose Port B (for example, Port 2) from the drop-down menu.

d. In the TXP Mode column, choose RX Only from the drop-down menu. CTC completes the Port B 
TXP Port with Port A and TXP Mode with TX Only. 

e. Click the Port B row and uncheck Flow Control Neg. 

f. Click Apply.

The ports on the CTC card level view display arrows and a line between the back of the ports.

TXP Mode columnConfirmation

TXP Port
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Figure 8-17 Two-Port Unidirectional Transponder Mode

Stop. You have completed this procedure.

NTP-A149 Test G-Series Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit.

TXP Mode columnConfirmation

TXP Port

Purpose This procedure tests circuits created on G-Series cards. 

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX, and one of the following:

NTP-A147 Create a G-Series STS Circuit, page 8-82

NTP-A148 Create a Manual Cross-Connect for a G-Series or E-Series Card 
in Port-Mapped Mode, page 8-84

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 2 Change the circuit and circuit ports to an OOS-MT service state:

a. Click the Circuits tab.

b. Click the circuit you want to test.

c. From the Tools menu, choose Circuits > Set Circuit State.

d. In the Set Circuit State dialog box, choose OOS_MT from the Target Circuit State drop-down menu. 

e. Check the Apply to drop ports check box.

f. Click OK.

Step 3 On the shelf graphic, double-click the circuit source card. 

Step 4 Click the Provisioning > Port tabs.

Step 5 Verify the following settings:

• State—OOS_MT

• Flow Control Neg—Checked or unchecked as indicated by the circuit or site plan

• Max Size—Checked or unchecked as indicated by the circuit or site plan

• Media Type— SX, LX, ZX, CWDM, or DWDM

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node, connect the Ethernet test to the destination port and configure the test set to send 
and receive the appropriate Ethernet traffic. 

Note At this point, you are not able to send and receive Ethernet traffic.

Step 8 At the source node, connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 8 to make sure you configured the Ethernet ports and test set 
correctly.

Step 10 Perform protection switch testing appropriate to the SONET topology:

• For path protection configurations, complete the “DLP-A94 Path Protection Switching Test” task on 
page 6-40.

• For BLSRs, complete the “DLP-A91 BLSR Switch Test” task on page 6-26.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 Change the circuit and circuit ports to the IS service state:

a. Click the Circuits tab.

b. Choose the circuit you want to test. 

c. From the Tools menu, choose Circuits > Set Circuit State.

d. In the Set Circuit State dialog box, choose IS from the Target Circuit State drop-down menu. 

e. Check the Apply to drop ports check box.

f. Click OK.

Step 12 After the circuit test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results, see your test set user guide. 
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Stop. You have completed this procedure.

NTP-A194 Create Overhead Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the 
overhead circuit. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 As needed, complete the “DLP-A313 Create a DCC Tunnel” task on page 8-93.

Step 4 As needed, complete the “DLP-A341 Create an IP-Encapsulated Tunnel” task on page 8-95.

Step 5 As needed, complete the “DLP-A83 Provision Orderwire” task on page 8-96.

Step 6 As needed, complete the “DLP-A212 Create a User Data Channel Circuit” task on page 8-97.

Stop. You have completed this procedure.

DLP-A313 Create a DCC Tunnel

Note Cisco recommends a maximum of 84 DCC tunnel connections. Terminated Section DCCs used by the 
ONS 15454 cannot be used as a DCC tunnel endpoint, and a Section DCC that is used as an DCC tunnel 
endpoint cannot be terminated. All DCC tunnel connections are bidirectional. 

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include DCC tunnels, IP-encapsulated tunnels, the AIC 
and AIC-I card orderwire, and the AIC-I card user data channel.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates an DCC tunnel to transport traffic from third-party 
SONET equipment across ONS 15454 networks. Tunnels can be created on 
the Section DCC channel (D1-D3) (if not used by the ONS 15454 as a 
terminated DCC), or any Line DCC channel (D4-D6, D7-D9, or D10-D12). 

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 6-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:

• Name—Type the tunnel name.

• Circuit Type—Choose one:

– DCC Tunnel-D1-D3—Allows you to choose either the Section DCC (D1-D3) or a Line DCC 
(D4-D6, D7-D9, or D10-D12) as the source or destination endpoints.

– DCC Tunnel-D4-D12—Provisions the full Line DCC as a tunnel.

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

• Channel—These options appear if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose one of 
the following:

– DCC1 (D1-D3)—This is the Section DCC.

– DCC2 (D4-D6)—This is Line DCC 1.

– DCC3 (D7-D9)—This is Line DCC 2.

– DCC4 (D10-D12)—This is Line DCC 3.

DCC options do not appear if they are used by the ONS 15454 (DCC1) or other tunnels.

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

• Channel—These options appear if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose one of 
the following:

– DCC1 (D1-D3)—This is the Section DCC.

– DCC2 (D4-D6)—This is Line DCC 1.

– DCC3 (D7-D9)—This is Line DCC 2.

– DCC4 (D10-D12)—This is Line DCC 3.

DCC options do not appear if they are used by the ONS 15454 (DCC1) or other tunnels.

Step 8 Click Finish.

Step 9 Put the ports that are hosting the DCC tunnel in service. See the “DLP-A214 Change the Service State 
for a Port” task on page 6-6 for instructions.

Step 10 Return to your originating procedure (NTP).
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DLP-A341 Create an IP-Encapsulated Tunnel

Note Each ONS 15454 can have up to ten IP-encapsulated tunnel connections. Terminated Section DCCs used 
by the ONS 15454 cannot be used as a tunnel endpoint, and a Section DCC that is used as a tunnel 
endpoint cannot be terminated. All tunnel connections are bidirectional. 

Step 1 Verify that IP addresses are provisioned at both the source and destination nodes of the planned tunnel. 
For more information, see the “DLP-A249 Provision IP Settings” task on page 4-10.

Step 2 In network view, click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create.

Step 4 In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:

• Name—Type the tunnel name.

• Type—Choose IP Tunnel-D1-D3.

• Maximum Bandwidth—Type the percentage of total SDCC bandwidth used in the IP tunnel (the 
minimum percentage is 10 percent). 

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

• Channel—Displays IPT (D1-D3).

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

• Channel—Displays IPT (D1-D3).

Step 9 Click Finish.

Step 10 Put the ports that are hosting the IP-encapsulated tunnel in service. See the “DLP-A214 Change the 
Service State for a Port” task on page 6-6 for instructions.

Purpose This task creates a an IP-encapsulated tunnel to transport traffic from 
third-party SONET equipment across ONS 15454 networks. 
IP-encapsulated tunnels are created on the Section DCC channel (D1-D3) 
(if not used by the ONS 15454 as a terminated DCC). 

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 6-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 11 Return to your originating procedure (NTP).

DLP-A83 Provision Orderwire

Step 1 In the network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create. 

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire 
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use 
either local or express orderwire channels. If regenerators exist, use the express orderwire channel. 
You can provision up to four ONS 15454 OC-N ports for each orderwire path.

• PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law 
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both 
types of orderwire.

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

For non-DWDM nodes, the slots and ports are OC-N cards. For DWDM nodes, the slots and ports are 
OSC cards. 

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

Purpose This task provisions orderwire on the AIC or the AIC-I card. 

Tools/Equipment An AIC or AIC-I card must be installed in Slot 9.

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
8-96
Cisco ONS 15454 Procedure Guide, R4.6

December 2004



 

Chapter 8      Create Circuits and VT Tunnels
DLP-A212 Create a User Data Channel Circuit
• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

For non-DWDM nodes, the slots and ports are OC-N cards. For DWDM nodes, the slots and ports are 
OSC cards. 

Step 8 Click Finish.

Step 9 Return to your originating procedure (NTP).

DLP-A212 Create a User Data Channel Circuit

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down menu. 
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

For non-DWDM nodes, the slots and ports are OC-N cards. For DWDM nodes, the slots and ports are 
OSC cards. 

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

Step 8 Click Finish.

Purpose This task creates a user data channel (UDC) circuit on the ONS 15454. A 
UDC circuit allows you to create a dedicated data channel between nodes. 

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-24

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 Return to your originating procedure (NTP). 

NTP-A227 Provision a DWDM Optical Channel Network 
Connection

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the DWDM 
OCHNC. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the OCHNC source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 6 Click Next.

Step 7 Define the circuit attributes:

• Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose one of the following options depending upon whether a TXP_MR_10G, 
MXP_MR_10G, TXP_MR_2.5G, or TXPP_MR_2.5G card is connected to the OCHNC end points:

– Equipped non specific—Choose this option if you do not know which card will be installed at 
the OCHNC end points. 

– Multi-rate—Choose this option if a TXP_MR_2.5G or TXPP_MR_2.5G card that is 
provisioned for Fiber Channel, Gigabit Ethernet, or ESCON (Enterprise Systems Connection) 
is connected to the OCHNC end points.

– 2.5 Gb/s No FEC— Choose this option if a TXP_MR_2.5G or TXPP_MR_2.5G card that is not 
provisioned for forward error correction (FEC) is connected to the OCHNC end points.

– 2.5 Gb/s FEC—Choose this option if a TXP_MR_2.5G or TXPP_MR_2.5G card that is 
provisioned for FEC is connected to the OCHNC end points.

Purpose This procedure creates an optical channel network connection (OCHNC) 
between ONS 15454s that are provisioned for DWDM. 

Tools/Equipment DWDM optical passive units (32 MUX-0, 32 DMX-0, 4MD-xx.x) and 
OADM (band or channel) cards must be installed at the nodes within the 
OCHNC route. 

Prerequisite Procedures NTP-A232 Verify DWDM Node Turn Up, page 7-2

NTP-A280 Provision DWDM or Hybrid Network Connections, page 7-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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– 10 Gb/s No FEC—Choose this option if a TXP_MR_10G or MXP_MR_10G card that is not 
provisioned for FEC is connected to the OCHNC end points.

– 10 Gb/s FEC—Choose this option if a TXP_MR_10G or MXP_MR_10G card that is 
provisioned for FEC is connected to the OCHNC end points.

• OCHNC Channel—Choose the wavelength you want to provision. Thirty-two wavelengths are 
available. See Table 5-6 on page 5-20 for a list of OADM channels.

• OCHNC Direction—Choose the line direction, either West to East to East to West. By default, West 
refers to ports located in Slots 1 to 7, and East refers to the ports located in Slots 11 to 17. 

– West to East—West is the receive (Rx) path and east is the transmit (Tx) path

– East to West—East is the Rx path and west is the Tx path

• Bidirectional—Check this check box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC.

Step 8 Click Next. 

Step 9 In the Circuit Source area, choose the source node from the Node drop-down menu. 

Step 10 Click Next. 

Step 11 In the Circuit Destination area, choose the destination node from the Node drop-down menu. 

Step 12 Click Finish. 

Stop. You have completed this procedure.

NTP-A264 Create an Automatically Routed VCAT Circuit

Note You can provision a maximum of two VCAT circuits for ML-Series cards.

Note For FC_MR-4 cards with a line rate 2-Gbps fiber channel, an equivalent VCAT circuit does not exist. A 
contiguous STS-48c circuit is used instead. FC_MR-4 cards with a line rate 1-Gbps fiber channel use 
eight VCAT members, each member using an STS-3c or STS-24c circuit. Software Release 4.6 supports 
line rate connections, not subrate connections. As a result, you cannot change the rate from 1-Gbps to 
2-Gbps if the circuit rate is STS-24c.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the VCAT 
circuit. If you are already logged in, continue with Step 2.

Purpose This procedure creates an automatically routed VCAT circuit. 

Tools/Equipment ML-Series or FC_MR-4 cards must be installed at the nodes used in the 
VCAT circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab, then click Create.

Step 4 In the Circuit Creation dialog box, choose STS-V from the Circuit Type drop-down menu. 

Step 5 Click Next.

Step 6 Define the circuit attributes (Figure 8-18 on page 8-101):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Displays the circuit type you chose in Step 4. You cannot change it.

• Bidirectional—Checked is the default. You cannot change it.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. 

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Not applicable.

• Symmetric—Checked is the default. You cannot change it.

• Member size—Choose the member size: STS-1c, STS-3c, or STS-12c. For FC_MR-4 cards, only 
STS-3c is available. 

• Num. of members—For VCAT circuits on FC_MR-4 cards, choose 8. For VCAT circuits on 
ML-Series cards, choose 2.

• Mode—Choose the protection mode for the VCAT circuit: 

– None—Provides no protection. A failure on one member causes the entire VCAT circuit to fail.

– Sw-LCAS—Allows the VCAT circuit to adapt to member failures and keep traffic flowing after 
failures at a reduced bandwidth.
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Figure 8-18 Setting VCAT Circuit Attributes

Step 7 Click Next. 

Step 8 Complete the “DLP-A324 Provision a VCAT Circuit Source and Destination” task on page 8-103 for the 
VCAT circuit you are creating.

Step 9 In the VCAT Circuit Routing Preferences area (Figure 8-19), check Route Automatically. Two options 
are available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created.

Note Software Release 4.6 only supports common fiber routing, where all members travel on the same 
fibers. 

Figure 8-19 Automatically Routing a VCAT Circuit

Step 10 In the Member Preferences area, complete the following:

• Number—Type a number (between 1 and 256) to identify the member.
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• Name—Type a unique name to identify the member. The name can be alphanumeric and up to 
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to the 
circuit.

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path; path protection is not supported.

– Unprotected—Creates an unprotected circuit.

– PCA—Routes the circuit on a BLSR protection channel. 

– Set protection for all members—Allows you to choose the same protection type for all 
members.

Note If a member is unprotected, all members must be unprotected.

Step 11 Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next 
step.

Step 12 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 13:

a. In the Circuit Route Constraints area, click a node or span on the circuit map.

b. Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

c. Repeat Step b for each node or span you wish to include or exclude.

d. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 13 If you selected Review Route Before Creation in Step 9, complete the following substeps; otherwise, 
continue with Step 14:

a. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

b. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A265 Create a Manually Routed VCAT Circuit” procedure on page 8-103 to assign the circuit 
route yourself.

Step 14 Click Finish. The Circuits window appears.

Step 15 In the Circuits window, verify that the circuit you created appear in the circuits list.

Stop. You have completed this procedure.
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DLP-A324 Provision a VCAT Circuit Source and Destination

Step 1 From the Node drop-down menu, choose the node where the circuit will originate.

Step 2 From the Slot drop-down menu, choose the slot containing the ML-Series cards or FC_MR-4 card where 
the circuit originates. (If a card’s capacity is fully utilized, it does not appear in the menu.)

Step 3 Depending on the circuit origination card, choose the source port and/or STS from the Port and STS 
menus. The Port menu is only available if the card has multiple ports. STSs do not appear if they are 
already in use by other circuits.

Step 4 Click Next.

Step 5 From the Node drop-down menu, choose the destination node.

Step 6 From the Slot drop-down menu, choose the slot containing the ML-Series cards or FC_MR-4 card where 
the circuit will terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear 
in the menu.)

Step 7 Depending on the card selected in Step 2, choose the source port and/or STS from the Port and STS 
menus. The Port menu is only available if the card has multiple ports. STSs do not appear if they are 
already in use by other circuits. 

Step 8 Click Next.

Step 9 Return to your originating procedure (NTP).

NTP-A265 Create a Manually Routed VCAT Circuit

Note You can provision a maximum of two VCAT circuits for ML-Series cards.

Purpose This task provisions a VCAT circuit source and destination.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Circuit Source panel must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a manually routed VCAT circuit. 

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 8-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note For FC_MR-4 cards with a line rate 2-Gbps fiber channel, an equivalent VCAT circuit does not exist. A 
contiguous STS-48c circuit is used instead. FC_MR-4 cards with a line rate 1-Gbps fiber channel use 
eight VCAT members, each member using an STS-3c or STS-24c circuit.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-24 at the node where you will create the circuit. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 8-11. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 In the Circuit Creation dialog box, choose STS-V from the Circuit Type drop-down menu. 

Step 5 Click Next.

Step 6 Define the circuit attributes (Figure 8-18 on page 8-101):

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Displays the circuit type you chose in Step 4. You cannot change it.

• Bidirectional—Checked is the default. You cannot change it.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. 

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 11-13.

• Apply to drop ports—Not applicable.

• Symmetric—Checked is the default. You cannot change it.

• Member size—Choose the member size: STS-1c, STS-3c, or STS-12c. For FC_MR-4 cards, only 
STS-3c is available. 

• Num. of members—For VCAT circuits on FC_MR-4 cards, choose 8. For VCAT circuits on 
ML-Series cards, choose 2.

• Mode—Choose the protection mode for the VCAT circuit: 

– None—Provides no protection. A failure on one member causes the entire VCAT circuit to fail.

– Sw-LCAS—Allows the VCAT circuit to adapt to member failures and keep traffic flowing after 
failures at a reduced bandwidth.

Step 7 Click Next. 
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Step 8 Complete the “DLP-A324 Provision a VCAT Circuit Source and Destination” task on page 8-103 for the 
VCAT circuit you are creating.

Step 9 In the Circuit Routing Preferences area (Figure 8-19 on page 8-101), uncheck Route Automatically. 

Step 10 In the Member Preferences area, complete the following:

• Number—Type a number (between 1 and 256) to identify the member.

• Name—Type a unique name to identify the member. The name can be alphanumeric and up to 48 
characters (including spaces). If you leave the field blank, CTC assigns a default name to the circuit.

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path; path protection is not supported.

– Unprotected—Creates an unprotected circuit.

– PCA—Routes the circuit on a BLSR protection channel. 

– Set protection for all members—Allows you to choose the same protection type for all 
members.

Note If a member is unprotected, all members must be unprotected.

Step 11 Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next 
step.

Step 12 In the Route Review and Edit area, node icons appear so you can route the circuit manually.

Step 13 Complete the “DLP-A325 Provision a VCAT Circuit Route” task on page 8-105.

Step 14 Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error 
message and allows you to change the circuit path. 

Step 15 When all the circuits are created, the main Circuits window appears. Verify that the circuit you created 
appear in the window.

Stop. You have completed this procedure.

DLP-A325 Provision a VCAT Circuit Route

Step 1 In the Circuit Creation wizard in the Route Review and Edit area, choose the member number from the 
Route Member Number drop-down menu.

Step 2 Click the source node icon if it is not already selected.

Purpose This task provisions the circuit route for manually routed OC-N circuits.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-24

The Circuit Creation wizard Route Review and Edit panel must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. In the Selected Span area, the From and To fields provide span information. The 
source STS appears. Figure 8-20 shows an example.

Figure 8-20 Manually Routing a VCAT Circuit

Step 4 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 3 and 4 until the circuit is provisioned from the source to the destination node through all 
intermediary nodes. 

Step 6 Repeat Steps 1 through 5 for each member.

Step 7 Return to your originating procedure (NTP).
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